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AÇIKLAMALAR 
 

KOD 482 BK 0016 
ALAN Elektrik Elektronik Teknolojisi 
DAL/MESLEK Alan Ortak 
MODÜLÜN ADI Bilgisayarla Devre Çizimi ve Simülasyonu 

MODÜLÜN TANIMI 
Elektrik elektronik devre ve şemalarını bilgisayar ortamında 
çizerek simülasyonunu yapabilme ile ilgili bilgi ve becerilerin 
kazandırıldığı öğrenme materyalidir. 

SÜRE 40/32 
ÖN KOŞUL Ön koşulu yoktur. 

YETERLİK 
Elektrik-Elektronik devre ve şemalarını bilgisayar ortamında 
çizerek simülasyonunu yapabilmek.  

MODÜLÜN AMACI 

Genel Amaç 
Elektrik elektronik devre şemalarını bilgisayar ortamında 
çizerek simülasyonunu yapabileceksiniz. 
Amaçlar 
1. Uygulama programının menülerini ve özelliklerini 

tanıyarak menü işlemlerini yapabileceksiniz. 
2. Analog test cihazlarını ve devre elemanlarını tanıyarak 

tasarım alanının içine yerleşimini yapabileceksiniz.  
3. Basit elektrik kanunlarının ispatlandığı devreleri, 

transistorlü ve opamplı devreleri tasarlayarak 
çalışmalarına ait sonuçları değerlendirebileceksiniz. 

4. Dijital test cihazlarını ve devre elemanlarını tanıyarak 
devre içine yerleşimini yapabileceksiniz. 

5. Basit kapıların ve dijital elemanların bulunduğu 
devreleri tasarlayarak çalışmalarına ait sonuçları 
değerlendirebileceksiniz. 

EĞİTİM ÖĞRETİM 
ORTAMLARI VE 
DONANIMLARI 

Ortam 
Bilgisayar laboratuvarı, elektrik-elektronik bilgisayar 
işletmeleri. 
Donanım 
Bilgisayar, projeksiyon cihazı, topex kamera, ploter, yazıcı, 
bilgisayar masaları, switch (veya hub) ile kurulmuş ağ yapısı, 
lisanslı elektrik-elektronik devre çizimi ve simülasyon 
programı. 

AÇIKLAMALAR 
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ÖLÇME VE 
DEĞERLENDİRME 

Her faaliyet sonrasında o faaliyetle ilgili değerlendirme 
soruları ile kendinizi değerlendireceksiniz.  
Öğretmen modül sonunda size ölçme aracı (uygulama, soru-
cevap) uygulayarak modül uygulamaları ile kazandığınız bilgi 
ve becerileri ölçerek değerlendirecektir. 

 
 
 



 

 vi 

 
 



 

 1 

 

GİRİŞ 
 

Sevgili Öğrenci, 
 
Bu modül sonunda, bilgisayar ortamında elektrik-elektronik alanında her türlü devre 

çizimi, simülasyonu ve analizini yapabileceksiniz. 
 
Günümüzde bütün ülkelerin üzerinde önemle durdukları ve giderek daha fazla kaynak 

sağladıkları alan, bilim ve teknolojidir. Varlıklarını sürdürmek isteyen toplumlar gelişen 
teknolojiyi takip etmek, değerlendirmek ve kullanmak zorundadırlar. 

 
Hayatımızın vazgeçilmez bir parçası olan bilgisayarın, özellikle, elektrik-elektronik 

alanında kullanımı her geçen gün artmaktadır. Bilgisayarın simülasyon amaçlı kullanımı bize 
hem zaman açısından hem de maddi açıdan avantajlar sağlamaktadır. 

 
Bu modülde elektronik alanında simülasyon, animasyon ve otomatik baskı devre 

çizimi yapan Proteus programının devre çizimi ve simülasyon bölümünü oluşturan ISIS 
programı uygulamalı olarak anlatılacaktır. 
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ÖĞRENME FAALİYETİ-1 
 
 
 
Uygun ortam sağlandığında uygulama programını çalıştırmak için gerekli donanım ve 

yazılımları, uygulama programının menülerini ve özelliklerini tanıyarak menü işlemlerini 
yapabileceksiniz. 

 
 
 
Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır: 

Ø Elektronik alanında kullanılan simülasyon programlarını araştırınız. 
Ø Elektronik simülasyon programlarının kullanım avantajlarını araştırınız. 

1. UYGULAMA PROGRAMI 
 

Labcenter Electronic firmasının bir ürünü olan Proteus görsel olarak elektronik 
devrelerin simülasyonunu yapabilen yetenekli bir devre çizimi, simülasyonu, animasyonu ve 
PCB çizimi programıdır. Klasik workbench'lerden en önemli farkı mikroişlemcilere 
yüklenen .HEX dosyalarını da çalıştırabilmesidir. Proteus gün geçtikçe genişleyen bir model 
kütüphanesine sahiptir. 

 
Proteus programı sanal bir laboratuvardır. Her türlü elektrik/elektronik devre şemasını 

Proteus yardımıyla bilgisayar ortamında deneyebilirsiniz. Devredeki elemanların değerlerini 
değiştirip yeniden çalıştırır ve sonucu gözlemleyebilirsiniz. Bu program, binlerce elektronik 
eleman içeren devre tasarımlarının üretiminde bile kullanılabilmektedir. Elektriksel hata 
raporu hazırlayabilmekte, malzeme listesini çok düzenli bir şekilde verebilmektedir.  

 
1.1. Programı Çalıştırmak İçin Gerekli Donanım ve Yazılımların 
Tanıtılması 

 
Bu bölümde Proteus programının tanıtılması, programın çalışabilmesi için gerekli 

donanım ve yazılımların tanıtılması, programın bilgisayarınıza kurulumu, Proteus ile birlikte 
yüklenen dosyalar anlatılacaktır.  

 
1.1.1. Programın Çalıştırılabilmesi İçin Gerekli Donanım ve Yazılımlar  

 
Proteus programı, Windows işletim sistemi altında çalışan bir programdır. Programın 

çalışabilmesi için bilgisayarınızda Windows 98 ya da üstü bir işletim sisteminin olması 
gerekmektedir. Proteus programının bilgisayarınızda verimli çalışabilmesi için, işlemcinizin 
en az Celeron ya da Pentium II, RAM belleğinizin de en az 32 MB olması gerekmektedir. 

ÖĞRENME FAALİYETİ–1 

AMAÇ 

ARAŞTIRMA 
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Program bilgisayara kurulduğunda harddiskinizde en az 60 MB’lık boş alana ihtiyaç 
duymaktadır. 

 
Programı bilgisayarınıza kurmak için program CD’sini CD ROM’unuza taktıktan 

sonra PROMEDO simgesinin üzerine çift tıklayınız. Karşınıza proteus kurulum penceresi 
gelecektir ve program bilgisayarınıza kurulmaya başlayacaktır. Bu pencereden Next 
butonuna tıklayarak programı bilgisayarınıza kurmaya başlayınız. Programın bilgisayara 
kurulumu aşamasında program sizi yönlendirecektir.  

 
Proteus programı siz değiştirmediğiniz takdirde Windows işletim sisteminde Başlat-

Programlar- Proteus 6 Demonstration menüsü altına yerleşecektir.  
 
1.1.2. Proteus ile Birlikte Yüklenen Dosyalar 
 

Proteus programı bilgisayarınıza yüklenirken beraberinde birçok dosya yüklenir. Şekil 
1.1’de Proteus 6 Demonstration seçeneği altında bulunan dosyalar yer almaktadır. 
 

 
Şekil 1.1: Proteus 6 Demonstration seçeneği altında bulunan dosyalar 

 
Proteus 6 Demonstration seçeneği altında bulunan dosyaların görevleri: 

Ø Proteus VSM Model Help: Proteus Library’sinde bulunan elektronik devre 
elemanlarının kullanım şekillerini anlatan yardım dosyaları. 

Ø About the Proteus Demo: Proteus 6 Professional hakkında dosyası. Bu dosya 
aracılığı ile, Proteus programı hakkında genel bilgiler alınabilir. 

Ø ARES 6 Demo: PCB ( baskılı devre ) çizim programı. 
Ø ARES Help:  Baskı devre çizim programının yardım dosyası. 
Ø ISIS 6 Demo: Elektronik devre çizim, simülasyon ve animasyon programı. 
Ø ISIS Help: Elektronik devre çizim, simülasyon ve animasyon programının 

yardım dosyası. 
Ø Licence Manager:  Lisans yöneticisi. 
Ø ProSPICE Help:  Prospice yardım dosyası. 
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Ø Read Me: Oku beni dosyası. Bilgisayarınıza kurduğunuz Proteus 6 programının 
eski versiyonlarından farkını ve ne gibi yenilikler getirdiğini açıklamaktadır. 

Ø Sample Designs: Programla birlikte gelen, örnek uygulamaları ve yardım 
tanıtım dosyası. Bu seçenek kullanılarak proteus programı bilgisayarınıza 
kurulurken beraberinde gelen örnek uygulamalar hakkında bilgi alınır. 

Bu programlar içinden ISIS 6 Demo konumuzu oluşturacaktır.  
 
1.1.3. ISIS Programının Çalıştırılması 
 

ISIS programı Proteus’un, devre çizim, simülasyon ve analiz programıdır. Proteus’un 
temelini teşkil eder. ISIS programını kullanarak her türlü elektronik devre çizimi, 
simülasyonu ve analizini yapabiliriz. ISIS’i çalıştırmak için: 

 
Başlat→ Programlar→ Proteus 6 Demonstration→ ISIS 6  

 
seçenekleri kullanılır. 
 

ISIS 6 seçeneğine tıkladıktan sonra program çalışmaya başlar.  
 

1.1.4. ISIS Programının Tanıtılması  
 

ISIS programı açıldıktan sonra karşımıza Şekil 1.2’deki ekran görüntüsü gelir. 
 
ISIS programının penceresinde en üstte  Başlık Çubuğu  yer almaktadır. Başlık 

çubuğunun hemen altında ise Menü Çubuğu vardır. Menü çubuğunun altında Araç 
Çubukları yer almaktadır. 

 
Programda toplam 7 adet araç çubuğu vardır.  Ekranın en üstünde yer alan araç 

çubukları sırasıyla;  
 

File/Print Commands ( Dosya/Yazdırma Araç Çubuğu ) 
Display Commands ( Display Araç Çubuğu) 
Editing Command ( Düzen Araç Çubuğu) 
Design Tools ( Dizayn Araçları) 
 
Bu araç çubukları View→Toolbars seçeneği altında yer alır. İstendiğinde bu araç 

çubukları ekrandan kaldırılabilir. 
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Şekil 1.2: ISIS programı ekran görüntüsü 

 
Ekranın sol tarafında ise 5. araç çubuğu olan Tasarım Araç Çubuğu yer almaktadır. 

Ekranın alt tarafında ise Orientation Toolbar (Yön araç çubuğu) ve The Animation Control 
Panel (Animasyon Kontrol Paneli ) yer almaktadır. 

 
Tasarım Alanı Ön Görünüş penceresinde, tasarım alanı içerisine yaptığımız 

çalışmanın küçültülmüşü yer almaktadır. Fare imlecini bu pencere içerisine götürüp bir kere 
sol tıklama ile tasarım alanı içindeki istediğimiz bölgeyi ekranda görüntüleyebiliriz. 

 
Elemanlar penceresinin üst kısmında yer alan P ve L butonları eleman çağırmak ve 

kütüphane yönetimi ( kütüphane silmek, yeni kütüphane oluşturmak, vb.) amacıyla 
kullanılır. P butonuna bir kere sol tıkladığımızda karşınıza ISIS programında bulunan bütün 
kütüphaneler ( üst kısımda ) ve devre elemanları ( alt kısımda ) gelecektir. 
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Ekranın en alt kısmında yer alan Durum Çubuğu  o anda yapılan işle ilgili kullanıcıyı 
bilgilendirmek için kullanılır. Ayrıca menüler içinde dolaşırken ve araç butonlarının üzerine 
fare imleciyle gelince, menü seçeneğinin ve araç butonlarının görevine dair kısaca bilgi 
vermektedir. 

 

 
Şekil 1.3: Eleman çağırma 

 
Koordinatlar yazan kısım, fare imleci tasarım alanında iken pozisyonu hakkında bilgi 

verir. Tasarım alanının tam ortası koordinatların orijin noktasını oluşturmaktadır. 
 
1.2. Isıs Programı Ana Menüsü 
 

ISIS programı ana menüsünde 12 seçenek bulunmaktadır. Bu menü seçeneklerinden 
her birinin üzerine farenin imleciyle gelip sol tıkladığınızda, o menü açılacak ve çeşitli 
seçenekler içeren pull-down bir menü karşınıza gelecektir.  

 
ISIS programında File, View, Edit, Tools, Design, Graph, Source, Debug, Template, 

System ve Help  ana menüleri yer alır. 
 

1.3. Isıs Programı Ana Menü Seçeneklerinin Tanıtılması 
 
1.3.1. File Menüsü 
 

Dosyaları ilgilendiren menüdür. File menüsünde dosyalarla ilgili komutlar yer alır. 

Ø New Design: Tasarım alanı üzerinde yeni bir devre çizimine başlamak için bu 
seçenek kullanılır. Bu seçenek kullanıldığında yeni bir tasarım alanı açılacak ve 
ismi UNTITLED.DSN olacaktır. 

Tasarım alanı üzerinde bir devre varsa ve bu devrede değişiklikler yapıldıktan sonra 
New Design seçeneği çalıştırılırsa, yeni bir tasarım alanı açılmadan önce bu devredeki 
değişiklikleri kaydedip kaydetmeyeceğimiz sorulur. 

Ø Load Design: Daha önce oluşturulan dosyayı tasarım alanına çağırmak için bu 
seçenek kullanılır. Bu seçenek çalıştırıldığında, yeni bir iletişim penceresi gelir. 
Bu iletişim penceresinden, çağrılacak olan dosyanın önce konumu, sonra da 
dosya adı seçilerek aç butonuna tıklandığında o dosya tasarım alanına yüklenir.  

Ø Save Design: Tasarım alanında yapmış olduğunuz çalışmaları kaydetmek için 
bu seçenek kullanılır. Yeni oluşturduğunuz bir çalışmayı kaydederken bu 
seçeneği çalıştırdığınızda bir iletişim penceresi açılır. Bu iletişim penceresini 
kullanarak dosyaya bir isim verdikten sonra dosyayı bilgisayarda 
kaydedeceğiniz konumu belirleyerek kaydedebilirsiniz. Dosyayı daha önce bir 
isimle kaydettiyseniz bu seçeneği çalıştırdığınızda, yaptığınız değişikliklerle 
birlikte bu seçeneği tekrar üstüne kaydetmiş olursunuz.  
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Şekil 1.4: File menüsü 

Ø Save Design As: Tasarım alanındaki çalışmanıza bir isim vererek kaydetmenizi 
sağlar. Üzerinde çalışma yaptığınız dosyayı başka bir isimle kaydetmek için de 
bu seçenek kullanılır. 

Save Design seçeneğinden farkı, bu seçenek her çalıştırıldığında Save Design iletişim 
penceresi karşınıza gelir.  

Ø Import Section: Bu seçenek ile daha önce yapılmış bir çalışmanın, bir bölümü 
ya da tamamı  ( Export Section seçeneği ile kaydedilmiş olması şartıyla) tasarım 
alanına çağrılarak dosyamıza eklenebilir.  

Bu seçeneğin kullanılmasındaki amaç; yapmış olduğumuz çalışmalarda, devrenin bir 
bölümü ya da tamamı tekrar başka çalışmalarda kullanılıyor ise yeniden oluşturmak yerine 
hazır çizimi kullanmak ve böylece zamandan tasarruf sağlamaktır. 

Ø Export Section: Tasarım alanındaki çalışmanın bir bölümünün ya da bir 
kısmının daha sonra başka çalışmalarda kullanılmak üzere kaydedilmesini 
sağlar. Devrenin bir bölümünü kaydetmek için; farenin imleci bölümün 
başlangıç noktasına getirilerek sağ tuşa basılı tutar blok içerisine alırız ve daha 
sonra bu seçeneği kullanarak bir isim veririz. Bu bölümü tekrar başka bir 
çalışmada kullanmak istediğimizde ise Import Section seçeneğini kullanırız. 

Ø Export Graphics: Tasarım alanındaki dosyamızı resim dosyası olarak 
kaydetmek için kullanılır. Bu seçeneğin alt seçenekleri vardır ve resim dosyası 
formatını seçmek sizin elinizdedir. Devrenizi değişik formatlarda kaydetme 
olanağınız mevcuttur. Bu seçeneklerden en çok tercih edileni Export 
Bitmap’dir. 
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Ø Mail To:Tasarım alanında üzerinde çalıştığınız dosyayı veya bitmiş çalışmayı 
Outlook Express programı aracılığı ile başka birisine e-posta olarak 
göndermenizi sağlar. 

Ø Print: Tasarım alanındaki çalışmayı kağıda aktarmak için kullanılır bu seçenek 
çalıştırıldığında karşımıza bir iletişim penceresi gelir. Çalışmanızı kağıda 
aktarmadan önce gereken ayarları bu iletişim penceresindeki seçenekleri 
kullanarak yapabilirsiniz.  

Ø Printer Setup: ISIS programı Windows işletim sistemi tarafından tanımlanıp 
yüklenmiş olan yazıcıyı kullanmaktadır. Siz aktif olan yazıcıyı değiştirmek, 
yazıcı ayarlarını yapmak, kağıt boyutunu seçmek istiyorsanız bu seçeneği 
kullanabilirsiniz.  

Ø Set Area: Bu seçenek tasarım alanındaki çalışmanın istenen bölümünün kağıda 
aktarılması için kullanılır. Set Area seçeneği çalıştırıldıktan sonra, tasarım 
alanındaki çalışmamızın, kağıda aktarılacak bölümü, farenin imleci başlangıç 
noktasına getirilir ve sol tuşa basılı tutularak, bitiş noktasına doğru sürüklenir. 
Yani yazılacak bölüm blok içerisine alınır. Daha sonra File menüsünden Print 
seçeneği çalıştırılarak karşımıza gelen pencereden Marked Area seçeneği 
işaretlenir ve diğer ayarlar yapılarak OK butonuna basılır ve işlem tamamlanır.  

Ø Exit : ISIS programından çıkmak için bu seçenek kullanılır. 

 
1.3.2. View Menüsü  
 

Bu seçenek ISIS programının ekran görüntüsünü ayarlamak için kullanılır. 
 

 
Şekil 1.5: View menüsü 
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Ø Redraw: Tasarım alanında bulunan çalışmanın ekran görüntüsünü tazelemek 
için kullanılır. Ekran görüntüsünü tazelememizin sebebi, tasarım alanında bir 
devre oluştururken yeni bir bağlantı yapmamızda veya varolan bir bağlantıyı 
sildiğimizde o an için ekran görüntümüz olması gerektiği gibi görünmeyebilir. 
Bu durumdan kurtulmak için Redraw seçeneği kullanılmaktadır.  

Ø Grid: Tasarım alanında bulunan ızgaranın görünüp/görünmemesini bu seçenek 
sağlar.  

Ø Orijin: Tasarım alanında yeni bir orijin noktası tanımlamak için kullanılır. ISIS 
programında tasarım alanında default orijin noktası, tasarım alanının tam orta 
noktasıdır. Fakat kullanıcı isterse kendisi bu seçeneği kullanarak farklı bir orijin 
noktası tanımlayabilir. Bu işlemi yaparken; farenin imlecini tasarım alanında 
orijin noktası olarak tanımlayacağımız yere getirir ve bu seçeneği çalıştırırsak 
yeni orijin noktamız artık burası olur. Koordinatları gösteren ve durum 
çubuğunun sağ tarafında yer alan rakamlar ise kırmızı rengi alır, bu da bize 
orijin noktasının kullanıcı tarafından tamamlandığını gösterir. 

Ayrıca bu seçenek kütüphaneye yeni bir eleman oluşturup eklemek için, kullanıcı 
tarafından oluşturulan elemanın orijin noktasını belirlemede kullanılmaktadır. 

Ø X Cursor: Tasarım alanının içindeki fare imleci şeklinin belirlenmesinde bu 
seçenek kullanılır. ISIS programı çalıştırıldığında tasarım alanındaki fare imleci 
default değerinde ve normal ok şeklindedir. Fakat bu seçenek çalıştırıldığında 
tasarım alanında fare imleci Şekil 1.6’daki şeklini alır. Bu seçenek bir defa daha 
çalıştırıldığında ise Şekil 1.7’deki şeklini alır. 

      
Şekil 1.6: Fare imlecinin x görüntüsü Şekil 1.7: Fare imlecinin + görüntüsü 

Ø Snap 10th- 50th- 100th-500th: Fare imlecinin tasarım alanında iken hareket 
adımlarını belirler. Bu adımları görebilmek için bu seçenekleri kullandığımızda 
koordinatlara bakmanız yerinde olur.  

Ø Pan: Bu seçenek çalıştırıldıktan sonra tasarım alanında iken fare imlecinin 
görüntüsü Şekil 1.8’deki halini aldıktan sonra, tasarım alanında farenin sol tuşu 
ile herhangi bir yere tıklandığında orası merkez seçilir ve ekran o noktadan 
merkezlenir. Bu seçeneğin amacı tasarım alanında bulunan devrenin istediğimiz 
bölgesini ekranda merkezlemektir.  

 
Şekil 1.8: Pan seçeneğinden sonra fare imlecinin görüntüsü 

Ø Zoom In: Tasarım alanında bulunan çalışmanın ekran görüntüsünü büyütür.  

Ø Zoom Out:  Tasarım alanında bulunan çalışmanın ekran görüntüsünü küçültür.  
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Ø Zoom All:  Tasarım alanının tamamını ekranı kaplayacak şekilde gösterir.  

Ø Zoom to Area: Tasarım alanında bulunan çalışmanın seçilen kısmını büyütmek 
için kullanılır. Bu seçenek çalıştırıldıktan sonra tasarım alanında fare imleci 
Şekil 1.9’daki görüntüsünü alır ve çalışma üzerinde bir alan belirlenir. Alan 
belirleme işlemi bittikten sonra o kısım görüntü olarak büyütülür. 

 
Şekil 1.9: Pan seçeneğinden sonra fare imlecinin görüntüsü 

Ø Toolbars: ISIS programı araç çubuklarının istenenin ekranda gizlenip, 
görünmesini sağlar. Bu seçenek çalıştırıldığında karşımıza Şekil 1.10’da verilen 
iletişim penceresi gelmektedir. Bu pencere içindeki onaylardan istediğimizi 
kaldırıp, OK tuşuna basarak araç çubuklarından isteneni ekran üzerinden 
kaldırabiliriz.  

 
Şekil 1.10: Araç çubuklarının ekranda görüntülenmesi 

 
1.3.3. Edit Menüsü 
 

Edit, kelime anlamı olarak düzenleme, değişiklik yapma gibi anlamlara gelmektedir. 
Bilgisayar literatüründe ise bu kelime, geri alma, yenileme, kopyalama, kesme, yapıştırma 
gibi işlemleri ifade etmektedir.  
 

 
Şekil 1.11: Edit menüsü 



 

 12 

Ø Undo: Bu seçeneğe her tıklamada, sırayla son yapılan işlemleri geriye doğru 
birer birer geri alır.  

Ø Redo: Son geri alınan işlemi tekrarlar, yani işlemi yeniden yapar. 

Ø Find and Edit Component: Tasarım alanında bulunan devredeki elemanları 
düzenlemek için bu seçenek kullanılır. Bu seçenek çalıştırıldığında karşınıza 
gelen iletişim penceresinde component yazısının yanındaki kutuya elemanın 
sembol ismini girip OK butonuna basarsanız elemanın düzenleme penceresi 
karşınıza gelir. 

Ø Edit Object Under Cursor: Bu seçenek çalıştırıldığında fare imlecini tasarım 
alanındaki herhangi bir elemanın üzerine getirdiğinizde o elemanla ilgili 
düzenleme penceresi karşınıza gelir.  

Ø Cut to clipboard: Seçilen elemanın ya da belirlenen alanı bulunduğu yerden 
kesip alır ( Kesilip alınan eleman ya da blok silinmez, Windows işletim sistemi 
panosuna alınır.).  

Ø Copy to clipboard: Seçilen elemanın ya da belirlenen alanın bir kopyasını alır ( 
Kopyalanan eleman ya da alan, Windows işletim sistemi panosuna alınır ve 
“Paste from clipboard”, seçeneği kullanılmadan görülemez.).   

Ø Paste From clipboard: Bu seçenek Cut to clipboard veya Copy to clipboard 
seçenekleri ile panoya alınan elemanı ya da bloğu istenen yere yapıştırır. Bu 
seçenek çalıştırıldığında panodaki eleman ya da blok, kırmızı renkli ve fare 
imlecinin ucunda ekrana gelir ve onunla birlikte hareket eder. Bunun nedeni ise 
yapıştırılacak alana götürülmesi gerektiğindendir. Götürüldükten sonra farenin 
sol tuşuna basılır ve işlem tamamlanır.  

Ø Send to back: Birbirinin üzerine istenmeden veya istenerek konmuş olan 
elemanlardan seçileni ötekinin altına gönderir. Bir eleman yerine konmadan ( 
yani üst üste gelmeden ) önce seçilerek bu seçenek çalıştırıldığında, o eleman 
hep altta kalır.  

Ø Bring to front: Birbirinin üzerini istenmeden veya istenerek konmuş olan 
elemanlardan seçileni ötekinin üstüne alır. Bir eleman yerine konmadan ( yani 
üst üste gelmeden ) önce seçilerek bu seçenek çalıştırıldığında, o eleman hep 
üstte kalır.  

Ø Tidy: Bu seçenek çalıştırıldığında elemenlar kutumuzda bulunan ve tasarım 
alanında hiç kullanılmayan elemanlar silinir. Dolayısıyla daha temiz ve derli 
toplu bir çalışma alanı olur.  

 
1.3.4. Library Menüsü 
 

Library, kelime anlamı olarak kütüphane demektir. Eleman çağırma, eleman 
oluşturma, kütüphaneyi düzenleme gibi kütüphane ile ilgili işlemleri yapmamızı sağlar.  
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Şekil 1.12: Library menüsü 

Ø Pick Device/Symbol: Library’den tasarım alanına ismini bildiğimiz bir elemanı 
çağırmak için bu seçenek kullanılır.  

Ø Make Device: Kütüphaneye yeni eleman oluşturulup eklemek için kullanılır.  

Ø Make Symbol: Kütüphaneye eklemek için oluşturulan yeni elemana sembol 
ismi vermek için kullanılır. 

Ø Packaging Tool: Kütüphaneye eklemek için oluşturulan yeni eleman 
paketlenerek kütüphaneye konulur. 

Ø Store Local Object: Yeni oluşturulan eleman kütüphane içinde istenen yere 
yerleştirilir. 

Ø Decompose: Kütüphanede var olan bir elemanı tasarım alanına çağırdıktan 
sonra, ayrıştırmak ( text, box, pin, pin number, vb.) için kullanılır. 
Ayrıştırmanın nedeni; bu elemandan faydalanarak yeni bir eleman yapmayı ya 
da bu elemana yeni özellikler kazandırmayı sağlamaktır. Bu seçeneği 
kullanabilmek için önce tasarım alanına eleman çağrılır. Daha sonra fare imleci 
üzerine getirilip sağ tıklanarak eleman seçilir ve kırmızı renk alması sağlanır. 
Bu işlemlerden sonra Decompose seçeneği çalıştırılırsa eleman ayrıştırılmış 
olur.  

Ø Compile to Library: Oluşturulan yeni eleman kütüphaneye derlenir. 

Ø Autoplace Library: Herhangi bir kütüphane dosyası seçilerek bu kütüphane 
içinde bulunan elemanlar DEVICES elemanlar kutusuna alınır. 

Ø Verify Packaging: Kütüphaneye paket olarak yerleştirilen elemanların doğru 
olarak yerleştirildiği test edilir.  

Ø Library Manager: Kütüphane ile ilgili her türlü işlem bu seçenek aracılığıyla 
yapılır. 
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1.3.5. Tools Menüsü 
 
Tools, kelime anlamı olarak araçlar demektir.  

 

 
Şekil 1.13: Tools menüsü 

Ø Real Time Annotation: Bu seçenek onaylı olduğunda tasarım alanına 
yerleştirilen elemanlara sembol numaraları sırasıyla verilir.  

Ø Real Time Snap: Bu seçenek onaylı olduğunda, tasarım alanında bulunan 
eleman pinlerinden herhangi birinin üzerine fare imleci getirildiğinde pin 
üzerinde x şekli oluşacak ve bağlantı yapılması daha kolay olacaktır. Bu 
seçenek onaylı değilse pin uçlarında x şekli oluşmayacaktır.  

Ø Wire Auto Router: Bu seçenekte otomatik bağlantı yolları belirlenir. Enable 
ise, program bağlantı yollarını kendisi belirler, disable ise kullanıcının kendisi 
belirler.  

Ø Search and Tag: Tasarım alanında bulunan şemada verilen kriterlere göre 
arama yapar ve arama sonuçlarına göre bulunan elemanı ya da  elemanları 
etiketler. Ayrıca durum çubuğunda kaç adet eleman bulunduğu ve etiketlendiği 
hakkında bilgi verir.  

Ø OR Search and Tag: Bu seçeneğin görevi, Search and Tag seçeneğine benzer. 
Farkı, ekstra bir kriter kullanılarak arama yapmaya olanak sağlar.  

Ø AND Search and Tag: Bu seçeneğin görevi Search and Tag seçeneğine benzer. 
Farkı, ekstra kriterler ile yapılan aramayı sınırlar. Arama esnasında 
karşılaşılması mümkün olmayacak tüm sonuçları etiketten temizler ve gerekli 
olanların kalmasını sağlar.  

Ø Property Assigment Tool: Özellik tanımlama seçeneğidir. Library’e eklemek 
için tasarım alanında oluşturulan elemana özellik tanımlamak için kullanılır.  

Ø Global Annotator: Tasarım alanında bulunan çalışmada, seçilen bir veya bütün 
elemanların sembol numaralarını istenen şekilde düzenlememizi sağlar.  
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Ø ASCII Data Import: Tasarım alanında bulunan çalışmaya  ASCII data dosyası 
eklemek için kullanılır. Bu seçenek ile mevcut eleman ( ASCII ) özelliklerinin 
ISIS dizayn dosyasına ya da sonradan oluşturulan kütüphane dosyasına aktarır.  

Ø Bill of Materials: Tasarım alanında bulunan çalışmanın eleman listesini çıkarır 
ve bu listeyi bir dosya haline getirerek bize sunar.  

Ø Electrical Rule Check: Tasarım alanında bulunan devrede elektriksel hata olup 
olmadığına dair rapor verir.  

Ø Netlist Compiler: Tasarım alanında bulunan devrenin ARES ’de PCB ( baskılı 
devresi )’yi otomatik olarak hazırlayabilmek için netlistini çıkarır.  

Tasarım alanında bulunan devrenin otomatik olarak baskılı devresini çıkarabilmek için 
yukarıda verilen netlist ayarlarının çok iyi yapılması gerekir.  

Ø Model Compiler: Yeni model dosyası derlemek için kullanılır.  

Ø Netlist to ARES: Tasarım alanında bulunan devrenin netlistini çıkarır ve 
ARES’e geçiş yapar.  

Ø Backannotate from ARES: ARES programı içinden Pinswap ve Gateswap 
sonuçlarını ISIS programına tekrar transfer eder.  

 
1.3.6. Design Menüsü 

 
Bu menü tasarım alanının düzenlenmesi ile (başlık, doküman no, revizyon, yeni 

tasarım alanı oluşturma, var olan tasarım alanını silme, tasarım alanları arası geçiş, vb.) ilgili 
işlemleri yapmak için kullanılır. 

 

 
Şekil 1.14: Design menüsü 

Ø Edit Design Properties: Bu seçenek tasarım dosyamıza; isim, doküman 
numarası, revizyon numarası ve açıklamalar eklemek için kullanılır. Bu seçenek 
çalıştırıldığında karşınıza Şekil 1.15’deki pencere gelir. 
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Şekil 1.15: Edit design properties penceresi 

 
• Title: Dizayn dosyasının başlığı yazılır. Bu başlık dosya raporlarında, 

netlist çıkarmada, vb. gibi işlemlerde kullanılır. 
• Doc.No: Doküman numarası yazılır. 
• Revizyon: Revizyon numarası yazılır. 
• Author: Çalışmayı yapan kişinin ismi yazılır. 
• Global Power nets? – Cache Model Files? : Netlist işlemleri için 

onaylanır. 

Ø Edit Sheet Properties: Bu seçenek üzerinde çalışma yapılan tasarım alanına 
başlık ve isim vermek için kullanılır. 

• Sheet Title: Tasarım alanı başlığı yazılır. 
• Sheet Name: Tasarım alanı ismi yazılır. 
• Annotator Init: Otomatik sembol numaraları için başlangıç değeri 

yazılır. 
 

 
Şekil 1.16: Edit sheet properties penceresi 

Ø New Sheet: Yeni bir tasarım alanı açar. ( Design menüsünden istenene geçilir.)  

Ø Remove Sheet: Çalışılan tasarım alanını yok eder.  

Ø Goto Sheet: İstenen tasarım alanına geçilir. Bu seçenek çalıştırıldığında 
karşımıza gelen pencereden istenen tasarım alanı seçilir ve “OK”  butonuna 
tıklanır.  

Ø Zoom to Child: Tasarım alanında bir elemanın hiyerarşik olarak, iç yapısı 
hakkında veya başka bir bilgi veriliyorsa, o bilgiyi görmek için kullanılır.  
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Ø Exit to Parent: Sub-circuit alanından ana çalışma alanına dönmek için bu 
seçenek kullanılır. 

Ø Root  Sheet: O anda üzerinde çalışılan tasarım çalışma alanını gösterir ve bu 
tasarım alanları arasında geçiş yapmak için kullanılır. ISIS programı ilk 
çalıştırıldığında bir tane tasarım alanı otomatik olarak oluşturulur ve default 
olarak Root Sheet 1 adını alır. New Sheet seçeneği ile ikinci bir tasarım alanı 
daha oluşturulursa bu tasarım alanı da Root Sheet 2 olarak adlandırılır. Bu 
tasarım alanlarına istediğimiz ismi vermek, daha önce anlattığımız gibi  Edit 
Design Properties seçeneği ile gerçekleştirilir. İstenen tasarım alanına geçmek 
için Design menüsünden o tasarım alanının isminin üzerine gelinerek tıklanır ve 
istenen tasarım alanına geçmiş olursunuz. 

 
1.3.7. Graph Menüsü 

 
Tasarım alanında bulunan çalışmamıza grafik eklemek, varolan grafiği düzenlemek, 

vb. gibi işlemleri bu menü yardımıyla gerçekleştirebilirsiniz. 

Ø Edit Gragh: Tasarım alanında bulunan çalışmamıza grafik eklemek 
,oluşturulmuş grafiği düzenlemek, simülasyon işlemini yapmak, vb. için 
kullanılır. Bu seçenek çalıştırıldığında karşımıza gelen grafik düzenleme 
penceresindeki bilgiler grafiğin özelliğine göre değişir. 

Ø Add Trace: Tasarım alanında bulunan grafiğe izleme noktası ( veya noktaları ) 
eklemek için kullanılır. Bu seçeneğin çalıştırılabilmesi için, tasarım alanında bir 
grafik elamanının olması gerekir. 

 
Şekil 1.17: Graph menüsü 

Ø Operating Point: DC işlem noktasını hesaplar. Tasarım alanında bulunan 
devrenin çıkışında voltaj ya da akım probu varsa ve grafikte de bu çıkış sinyali 
y ekseninde gösteriliyorsa, bu seçenek çalıştırıldığında çıkış sinyali başlangıç 
noktası gösterilir. 

Ø Simulate Graph: Tasarım alanında bulunan devrede değişiklik yapılmış ve bu 
değişiklik grafiği etkiliyorsa bu seçenek kullanılarak grafik tekrar oluşturulur.  

Ø View Log: Tasarım alanında oluşturulan grafiğin Simulate Graph seçeneği ile 
simüle işlemini yaptıktan sonra bu seçenek çalıştırıldığında, simülasyon ile ilgili 
bilgiler veren pencere karşınıza gelecektir.  
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Ø Export Data: Tasarım alanında bulunan grafiğin zamana bağlı olarak 
matematiksel verilerini bir dosya olarak kaydetmek için kullanılır. 

Ø Restore: Grafiğin simüle işlemini yenilemek için kullanılır. 

Ø Conformance Analysis: Tasarım alanında oluşturulan grafiğin kontrolünü 
yapar. 

 
1.3.8. Source Menüsü  

 
Tasarım alanında bulunan devremizde, programlanabilen entegrelerden herhangi biri 

veya birkaçı bulunuyorsa, bu entegrelerin çalıştıracağı kaynak kodlarla ilgili işlemler yapılır. 
 

 
Şekil 1.18: Source menüsü 

Ø Add/Remove Source Files: Tasarım alanında bulunan programlanabilir 
entegreye yüklenecek olan kaynak kod Assembly formatında ise bu seçenek ile 
kaynak kod tanımlanmalı ve hangi formata göre ( intel, motorola, microchip, 
vb. gibi ) kod üretilip çalıştırılacağı belirlenmelidir. 

Ø Define Code Generation Tools: Bu seçenek çalıştırıldığında karşımıza gelen 
pencereden ayrıntılı olarak kod üretme seçenekleri ayarlanabilir. 

Ø Setup External Text Editör: Kaynak kod için text editör tanımlaması yapılır. 

Ø Build All: Tanımlanan kaynak dosya çalışmaya hazır hale getirilir. 

 
1.3.9. Debug Menüsü  

 
Tasarım alanında bulunan devrenin çalışması, durdurulması, adım adım çalıştırılması, 

vb. gibi işlemlerin yapılabilmesi için kullanılır. Bu menü iki durumda incelenmelidir. Bu iki 
durumdan birincisi; tasarım alanında bulunan devrenin çalıştırılmadan önceki durumu, ikinci 
durum ise; tasarım alanında bulunan devrenin çalıştırıldıktan sonraki durumudur. 
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Şekil 1.19: Tasarım alanında bulunan devrenin çalıştırılmadan önceki debug menüsü 
 

 
Şekil 1.20: Tasarım alanında bulunan devrenin çalıştırıldıktan sonraki debug menüsü 

 

Ø Start / Restart Debugging: Tasarım alanında bulunan devreyi adım adım 
incelemek üzere çalıştırır ve hemen pause yapar.  

Ø Pause Animation: Tasarım alanında bulunan devrenin çalışmasına ara verir. 
Devrenin çalışması o anda durur ve devre Restart yapıldığı anda devrenin 
çalışması kaldığı yerden devam eder. 
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Ø Stop Annimation: Tasarım alanında bulunan devrenin çalışmasını durdurur. 
Devrenin çalışması tekrar start yapıldığında simülasyon işlemi tekrar baştan 
başlar. 

Ø Step Over: Tasarım alanında bulunan devreyi adım adım çalıştırır. 

Ø Step Into: Aktif olan fonksiyonu veya alt programı (subroutine) çalıştırır. 
Ayrıca bu seçenek, kaynak pop-up penceresi aktif iken kullanılır. 

Ø Step Out: Devrenin çalışması adım adım çalıştırılmama durumundan 
çıkarılarak normal çalışma moduna dönülür. 

Ø Step To: Bu seçenek animasyonu, kursörün o anki pozisyonuna ulaşana kadar 
çalıştırır. Ayrıca bu seçenek, kaynak pop-up penceresi aktif durumdayken 
kullanılabilir. 

Ø Excute: Tasarım alanında bulunan devreyi çalıştırır. 

Ø Reset Popup Windows: Bu seçenek çalıştırıldığında, VSM simülasyon 
pencereleri normal ayarlarına döner. 

Ø Reset Persistent Model data: EPROM ve EEPROM serisi elemanlarda datayı 
resetler. Yani simülasyon işlemi başladıktan sonra EPROM’arın içeriği değişti 
ise bu seçenek çalıştırıldıktan sonra EPROM’ların içeriği simülasyon başladığı 
andaki değerini alır. 

Ø Use Remote Debug Monitor: VSM simülasyonu için Virtual Debug Monitör’ü 
enable eder. 

Ø Tile Horizontally: ISIS programı içinde açık açık bulunan pencereleri, ekranı 
yatay kaplayacak şekilde yerleştirir. 

Ø Tile Vertically: ISIS programı içinde açık açık bulunan pencereleri, ekranı 
dikey kaplayacak şekilde yerleştirir. 

 
1.3.9.1. Tasarım Alanında Devre Çalışıyor Durumdayken Debug Menüsü Altında 
Oluşan Seçenekler 

Ø Simulation Log: bu seçenek devre çalıştırıldıktan sonra seçilebilir. Bu seçenek 
bize, devre simülasyonunun çalışması ile ilgili( netlist, spice models, devrenin 
derlenmesi, besleme hataları, vb. gibi. ) bilgiler verir. Eğer devremizde hata 
varsa karşımıza gelen Simulation  Log penceresinde hatanın bildirildiği satır en 
son satır olan ve Warning ile başlayan kısımdır. 

Ø Watch Window: Bu seçenek çalıştırıldığında izleme penceresi adını 
verebileceğimiz pencere karşınıza gelir. Bu pencere aracılığı ile devremiz ile 
ilgili izleme noktaları ve breakpoints adı verilen kontrol noktaları 
oluşturabiliriz. 
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1.3.10. Template Menüsü 
 
Bu menü, tasarım alanının ve tasarım alanında bulunan her şeyin ( ızgaranın, yolların, 

grafiklerin, şasenin, kutuların, yazıların, vb. gibi ) rengini, yazıların yazı tipi ile 
büyüklüğünü, yolların kalınlığını vb. işlemleri yapar. 

 

 
Şekil 1.21: Template menüsü 

Ø Set Design Defaults: Bu seçenek tasarım alanının rengini ve simülasyon 
sırasında oluşan sinyal renklerini ayarlamak için kullanılır. 

 
Şekil 1.22: Set Design Defaults penceresi 

• Colours Grubu 

o Paper Colour: Tasarım alanının rengi seçilir. 
o Grid Dot Colour: Izgaranın rengi seçilir. 
o Work Area Box Colour: Tasarım alanı ön görünüş kısmında, 

çalışma alanı kutusunun rengi seçilir. 
o Worl Box Colour: Tasarım alanını çevreleyen çizginin rengi 

seçilir. 
o Highlight Colour: Tasarım alanında bulunan devrede seçili 

elemanın rengi ayarlanır. 
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o Drag Colour: Tasarım alanında bulunan bir devrede bir eleman 
sürüklenirken alacağı rengi ayarlanır. 

• Animation Grubu  

o Positive Clour: Pozitif potansiyele sahip yolların rengi seçilir. 
o Ground Colour: Şase potansiyeline sahip yolların rengi seçilir. 
o Logic 1 Colour: Lojik 1 seviyesi rengi seçilir. 
o Logic 0 Colour: Lojik 0 seviyesi rengi seçilir. 
o Logic ? Colour: Devamlı değişen lojik seviye rengi seçilir. 

• Hidden Objects Grubu  

o Show hidden text ?: Onaylanırsa gösterilmeyen gizli yazılar 
gösterilir. 

o Show hidden pins: Onaylanırsa gösterilmeyen gizli pinler 
gösterilir. 

o Hidden Colour: Gösterilmeyen yazı ve pin rengi seçilir. 

• Font face for Default Font Grubu 
 
Tasarım alanında bulunan yazıların yazı tipi seçilir. 

Ø Set graph colours: Bu seçenek grafik ile ilgili renk ayarlarını yapmak için 
kullanılır. 

• General Appearance Grubu  

o Graph Outline: Grafik kenar çizgi ve bölme çizgisi renkleri 
seçilir. 

o Background: Grafik arka plan rengi seçilir. 
o Graph Title: Grafik başlık rengi seçilir. 
o Graph Text: Grafik yazı rengi seçilir. 

 
Şekil 1.23: Graph colour configuration penceresi 
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• Analogue Traces Grubu 
 
Analog sinyal renkleri seçilir. 
 

• Digital Traces Grubu 
 
Dijital sinyal renkleri seçilir. 

Ø Set Graphics Styles: Bu seçenek global ( analiz grafikleri haricindeki diğer 
grafikler ) grafik stillerini ayarlamak için kullanılır.  

 
Şekil 1.24: Edit global graphics style penceresi 

 
• Style Grubunda aşağı açılır kutudan hangi grafik ayarının yapılacağı 

belirlenir. 
 

• Line Attributes Grubu 

o Line style: Grafiği çevreleyen çizgi stili seçilir. 
o Width : Çizgi kalınlığı seçilir. 
o Colour: Çizgi rengi seçilir. 

• Fill Attributes Grubu 

o Fill Style: Grafiğin içini belirlenen stille doldurur. 
o Fg. Colour: Grafiğin içini dolduran stilin rengi seçilir. 
o Use Bk. Colour: Arka plan rengi kullanılıp kullanılmayacağı 

sorulur. Eğer onaylanırsa arka plan rengi kullanılır. 
o Bk. Colour: Arka plan rengi seçilir. 

Sample kutusunda yapılan ayarlara göre grafiğin önizlemesi gösterilir. 
 
New butonu ile kullanıcı yeni bir grafik stili oluşturabilir. 
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Ø Set Text Styles: Bu menü tasarım alanında oluşturulan devre elemanların sahip 
olduğu yazıların yazı tipini, yüksekliğini, rengini ve efektifini ayarlamak için 
kullanılır. 

 
Şekil 1.25: Edit global text styles penceresi 

 
Style yazısının yanındaki aşağı açılır kutudan ayarı yapılacak olan bölüm seçilir. 

• Font face: Yazı tipi seçilir. 

• Height: Yazının yüksekliği seçilir. 

• Colour: Yazının rengi seçilir. 

Ø Set Graphics Text: 2D grafiklerinde kullanılan yazıların yazı tipini, 
büyüklüğünü ve efektini ayarlamak için kullanılır. 

Ø Set Junction Dots: Bu seçenek tasarım alanında oluşturduğumuz devrede 
kullanılan bağlantı noktalarının ayarlarını yapmak için kullanılır ( Şekil 26 ). 

 

 
Şekil 1.26: Configure junction dots penceresi 

 
• Size: Bağlantı noktalarının büyüklüğü seçilir. 
• Shape: Bağlantı noktalarının şekli ayarlanır ( Square: kare, Round: 

yuvarlak, Diamond: baklava dilimi). 
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Ø Apply Template From Design: Bu seçenek başka bir ISIS dosyasının 
ayarlarını çalıştığımız dosyaya uygular. Çalıştırıldığında karşımıza gelen 
pencereden dosya seçilir ve butonuna tıklanırsa, bu dosyanın tasarım alanı 
ayarları o an çalışılan dosyaya uygulanır. 

Ø Save Default Template: Yapılan ayarları kaydetmek için kullanılır. 

1.3.11. System Menüsü 
 
Bu menü ISIS programının sistem ayarlarını yapmak için kullanılır.  

Ø System Info: Programın versiyonu ve lisans ile ilgili bilgiler verir. 

Ø Text Viewer: Hata, simülasyon log, vb. gibi mesajları gösterir. 

Ø Set BOM Scripts: Bu seçenek Tools-Bill of Materials seçeneğinin 
çalıştırılmasıyla elde edilen devrenin eleman listesi raporunun konfigürasyon 
ayarının yapılmasına olanak sağlar. 

 
Şekil 1.27: System menüsü 

Ø Set Environment: Bu seçenek çalıştırıldığında karşımıza gelen menüden ortam 
ayarları yapılır (Şekil 1.28). 

• Autosave Time (minutes): Çalışmayı otomatik kaydetme süresi seçilir. 
• Number of Undo Levels: Undo (geri al) seçeneğinin kaç işlemi hafızada 

tutacağı seçilir. 
• Tooltip Delay (milliseconds): Bilgi penceresi gecikme süresi seçilir. 
• Number of filenames on File menu: Dosya menüsü altında son çalışılan 

kaç dosyanın görüntüleneceği seçilir. 
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• Auto Syncronise/Save with ARES?: Onaylandığında ISIS programı ön 
plana geldiğinde ARES’de çalışılan dosya otomatik olarak kaydedilir. 

 

 
Şekil 1.28: Environment configuration penceresi 

 
• Save /load ISIS state in design files: Onaylandığında tasarım alanında 

bulunan dosya ile birlikte ISIS programının ayarlarında yaptığınız 
değişiklikler de otomatik olarak kaydedilir ve bu dosya ile birlikte aynı 
ayarlar çağrılmış olur. 

• Initial Menu Settings Grubu 

o Grid Dots: ISIS programı çalıştırılırken ızgaranın ekranda 
görünüp görünmemesini ayarlar. Bu seçeneğin onayını kaldırıp 
System-Save Preferences seçeneği ile değişikliği kalıcı hale 
getirirseniz ızgara artık ekranda görünmez. 

o Real Time Annotation: ISIS programının ilk açılışında Real 
Time Snap seçeneğinin aktif olup olmamasını ayarlar. 

o Wire Autorouter: ISIS programının ilk açılışında Wire 
Autorouter seçeneğinin aktif olup olmamasını ayarlar. 

Yukarıda anlatılan seçeneklerde değişiklik yapıldığında, bu değişikliklerin geçerli 
olabilmesi için System-Save Preferences seçeneğini onaylamanız gerekir. 

o Cursor Type Grubu 

None: Onaylanırsa ISIS programının her açılışında fare imleci ok şeklinde görünür. 
Small X Cursor: Onaylanırsa ISIS programının her açılışında fare imleci X şeklinde 

görünür. 
Cross Hair Cursor: Onaylanırsa ISIS programının her açılışında fare imleci + 

şeklinde görünür. 

Ø Set Paths: ISIS programının kullanıldığı Library, Model ve simülasyon 
sonuçları yolları tanımlanır, yeni yollar varsa “+” butonu ile eklenir. 
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Ø Set Property Definitions: ISIS programı kütüphanesine yeni elemanlar 
oluşturulurken oluşturulacak olan elemanların genel tanımlama ayarları yapılır. 

Ø Set Sheet Sizes: Tasarım alanı boyutları ayarlanır. Bu seçenek çalıştırıldığında 
karşınıza gelen iletişim penceresinden istenen ayarları yapabilirsiniz. 

Ø Set Text Editör: Text editör yazı tipi, yazı tipi stili, yazı boyutu, yazı efekti ve 
rengi ayarlanır. 

Ø Set Animation Options: Programın animasyon ayarlarını yapmak için 
kullanılır. Bu seçenek çalıştırıldığında Şekil 1.29’daki pencere karşınıza gelir. 

• Simulation Speed Grubu 

o Frames per Second: Saniye başına çerçeve sayısı belirlenir. 

o Time per Frame: Çerçeve başına zaman dilimi belirlenir. 

o Single Step Time: Tek adım zamanı belirlenir. 

 
Şekil 1.29: Animated circuits configuration penceresi 

 
• Voltage/Current Ranges Grubu 

o Maximum Voltage: Maksimum voltaj değeri belirlenir. 

o Current Threshold: Eşik akım değeri belirlenir. 

• Animation Options Grubu 

o Show Voltage&Current on Probes?: Onaylanırsa voltaj ve akım 
problarını gösterir. 

o Show Logic state of pins?: Onaylanırsa pinlerde lpjik durumları 
gösterir. 

o Show Wire Voltage by Colour?: Onaylanırsa gerilim yolunu 
renkli gösterir. 

o Show Wire Current with Arrows: Onaylanırsa akım yolunu ok 
ile gösterir. 
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Ø Set Simulator Options: Simülasyon ayarlarını yapmak için kullanılır. Bu 
seçenek çalıştırıldığında açılan Interactive Simulation Options penceresinden 
simülasyon ayarlarınızı yapabilirsiniz. 

Ø Save Prefences: Bu seçenek “System” menüsü altında yapmış olduğumuz 
ayarların kaydedilmesi için kullanılır. 

1.3.12. Help Menüsü 
 

Proteus programı yardım menüsüdür. 
 

 
Şekil 1.30: Help menüsü 

 

Ø ISIS Help: Bu seçenek çalıştırıldığında karşınıza standart Windows yardım 
iletişim penceresi gelecektir. Yardım istenen konu sol taraftaki bölmeden 
seçilerek sağ taraftaki bölmeden açıklama okunur. 

Ø Proteus VSM Help: Proteus VSM simülasyonu hakkında yardım penceresini 
ekrana getirir. 

Ø Proteus VSM SDK: Proteus VSM SDK hakkında yardım penceresini ekrana 
getirir. 

Ø Sample Design: Proteus programının SAMPLES klasöründe bulunan örnek 
çalışmalar listelenir ve çağrılarak incelenebilir. 

Ø Stop Pres: Bu seçenek çalıştırıldığında Proteus Readme Help File penceresi 
karşımıza gelir ve bu versiyonda ne gibi yenilikler olduğu anlatılır. 

Ø About ISIS: Proteus programının versiyonu, lisans, boş hafıza ve işletim 
sisteminiz hakkında kısaca bilgi veren bir pencere karşınıza gelir. 

 
1.4. Isıs Programı Araç Çubukları 

 
ISIS programında 7 adet araç çubuğu bulunmaktadır.  

Ø Mode Selector Toolbar ( Tasarım [ Mod Seçim ] Araç Çubuğu )  
Ø File/Print Commands ( Dosya/Yazdırma ) 
Ø Display Commands ( Display )  
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Ø Editing Commands ( Düzen ) 
Ø Design Tools ( Dizayn Araçları ) 
Ø Orientation Toolbar ( Yön Araç Çubukları ) 
Ø Animasyon Kontrol Paneli 

1.4.1. Mode Selector Toolbar (Tasarım Araç Çubuğu) 
 

Bu araç çubuğu üç bölümden oluşur.  
 
1.4.1.1. Main Modes (Ana Modlar)  
 

 

Component: Tasarım alanına eleman çağırmak ve elemanları listelemek 
için kullanılır. 

 

Junction dot: Junction ( birleşme noktası ) koyar. 

 

Wire label: Wire ( iletken bağlantısı ) etiketlemek, isimlendirmek için 
kullanılır. 

 
Text scripts : Text ( metin ) yazmak için kullanılır. 

 

Bus : Bus ( çoklu iletken ) çizmek için kullanılır. 

 

Sub- circuit: Entegre devre oluşturmakta kullanılır. 

 
Instant edit mode: Eleman seçmek ve düzenlemek için kullanılır. 
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1.4.1.2. Gadgets 
 

 
Inter-sheet Terminal: Terminal eklemek için kullanılır. 

 
Device pin: Pin eklemek için kullanılır. 

 
Simulation Graph: Simülasyon grafiği oluşturmak için kullanılır. 

 
Tape Recorde: Bir devrede bir bölümün çıkışını yakalamak için kullanılır. 

 
Generator: Sinyal üreteçleri. Her türlü sinyal üretilebilir. 

 
Voltage Probe: Gerilim probu 

 
Current Probe: Akım probu 

 

Display operating point data: Kullanıcı kütüphanesinde VSM cihazları 
listeler ve kullanımımıza sunar. Ayrıca simülasyon esnasında, devredeki  
bir işlem noktasının tespitinde bulunur. 
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1.4.1.3. İki Boyutlu Grafik (2D Graphics)  
 

      
2D Graphics Line : Çizgi çizer. 

 
2D Graphics Box: Kutu çizer. 

 
2D Graphics Circle: Çember çizer. 

 

2D Graphics Arc: Yay çizer. 

 
2D Graphics Path: İstenen bir geometrik şekil çizer. 

 
2D Graphics Text: yazı yazmak için kullanılır. 

 

2D Graphics Symbol: Tasarım alanında bulunan sembolü düzenlemek 
veya yeni oluşturulan elemana sembol ismi vermek için kullanılır. 

 

Markers for component orgin, etc: Tasarım alanı orijinini ve yeni 
oluşturulanın elemanın orijinini belirlemede kullanılır. 

 
1.4.2. Dosya /Yazdırma Araç Çubuğu (File/Print Commands) 
 

 
Create a new design: Yeni bir dizayn dosyası oluşturur. 

 
Load a new design: Daha önceden var olan bir dizayn dosyasını çağırır. 

 
Save current design: Çalışılan dizayn dosyasını kaydeder. 

 

Import ISIS section file: Başka bir dizayn dosyasından belirlenmiş bir 
bloğu çalışılan dizayn dosyasına alır. 

 

Export tagged objects to section file: Çalışılan bir dizayn dosyasından 
belirlenmiş bir bloğu başka bir dizayn dosyasına taşır.  

 
Print or plot design: Aktif olan dizayn dosyasını yazdırır. 

 

Mark area to be printed: Bu buton seçildikten sonra tasarım alanındaki 
devreden belirli bir alan seçilir ve print butonsi seçilirse, yalnızca 
belirlenen alan yazdırılır. 
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1.4.3. Display Araç Çubuğu (Display Commands) 
 

        
Readraw editing and overview Windows: Tasarım alanı ekranını yeniler.  

 
Enable/Disable grid dot display: Izgarayı çağırır ya da gizler. 

 

Enable/Disable manuel origin specification: Manuel orijin özelliklerini 
enable/disable  

 

Re-centre the display: Bu buton seçildikten sonra, tasarım alanında  
herhangi bir yere tıklanırsa orası merkez seçilir ve ekran o noktadan 
merkezlenir. 

 

Increase magnification: Tasarım alanındaki görüntüyü büyütür. 

 
Decrease magnification: Tasarım alanındaki görüntüyü küçültür. 

 

View entire sheet: Tasarım alanının tamamını ekranda gösterir. 

 

View selected area: Bu buton seçildikten sonra bir alan belirlenirse o alan  
büyütülür. 
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1.4.4. Editing Commands ( Düzen Araç Çubuğu ) 
 

 

Undo last operation: Son yapılan işlemi geri alır. 

 

Redo the last undone operation: Son yapılan geri alma işlemini iptal 

eder. 

 

Cut the specified items to the clipboard: Seçilen elemanı ya da 

belirlenen bloğu keserek, panoya alır. 

 

Copy the specified items to the clipboard: Seçilen elemanı ya da 

belirlenen bloğu panoya kopyalar. 

 

Paste the specified items from hte clipboard: Panodaki elemanı ya da 

bloğu yapıştırır. 

 

Copy tagged objects: tasarım alanında seçilen bir elemanı ya da belirlenen 

bir bloğu kopyalayarak çoğaltır. 

 

Move tagged objects: Tasarım alanında seçilen bir elemanı ya da 

belirlenen bir bloğu başka bir yere taşır. 

 

Delete tagged objects: Tasarım alanında seçilen bir elemanı ya da 

belirlenen bir bloğu siler. 

 

Pick or update device/symbol: Kütüphaneden tasarım alanına eleman 

çağırmak için kullanılır. 

 

Form tagged graphics/pads into device and place in libraray: Yeni bir 

eleman oluşturmak için kullanılır. 

 

Launch the Visual Packaging Tool: Tasarım alanında bir eleman seçilir 

ve bu butona tıklanırsa, seçilen elemanın PCB ayak bağlantıları ekrana 

gelir. 

 

Break tagged object(s) into primitives: Kütüphaneye eleman 

oluştururken etiketlemede kullanılır. 
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1.4.5. Design Tools ( Dizayn Araçları ) 
 

 

Enable/Disable real-time snap: Bu buton aktifken tasarım alanında 
bulunan eleman pinlerinden herhangi birinin üzerine gelindiğinde x işareti 
oluşacak ve bağlantı yapılabilecektir. 
 

 

Enable/Disable wire auto-router: Bu buton aktifken, proğram bağlantı 
yollarını tomatik olarak belirler ( enable ). Buton aktif değilken bağlantı 
yollarını kullanıcı kendisi belirler ( disable ). 
 

 

Search and tag components with matched property values: bu buton 
aktif hale getirildiğinde eleman arar ve denk olan elemanları etiketler. 
 

 

General property management tool: Property Assigmant Tool 
penceresini çağırır. 
 

 

Create a new root sheet: Yeni bir tasarım alanı açar. 
 

 

Remove current sheet: Üzerinde çalışılan tasarım alanını siler. 
 

 

Goto specfic root or hierarchical sheet: İstenen tasarım alanına gitmek 
için kullanılır. 
 

 

Enter sheet of object pointed at ( use keyboard ): Hiyerarşik tasarımda 
alt çalışma sayfasına geçmek için kullanılır. 
 

 

Leave current sheet and return to parent: Üzerinde çalışılan tasarım 
alanından çıkıp kök çalışma alanına gitmek için kullanılır. 
 

 

Generate bill of materials reports: Tasarım alanında kullanılan 
elemanların listesinioluşturmak için kullanılır. 
 

 

Generate electrical rules check report: Bu butona tıklandığında karşınıza 
gelen iletişim penceresinden devrede elektriksel hata olup olmadığını 
öğrenebilirsiniz. 
 

 

Generate netlist and switch to ARES: Netlist çıkarılır ve aynı anda 
ARES programına geçilir. ISIS programı da aktif kalır. 
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1.4.6. Orientation Toolbar( Yön Araç Çubuğu )  
 

      

Rotate Clockwise: Seçilen elemanı 90˚ sağa döndürür. 
 

 

Rotate Anticlocwise: Seçilen elemanı 90˚  sola döndürür. 
 

 

Angle : Elemanı istediğiz derecede döndürmek için kullanılır. 
 

 

Horizontal reflection : Elemanın yatayda ayna görüntüsünü alır. 
 

 

Vertical reflection: Elemanın dikeyde ayna görüntüsünü alır. 
 

 
1.4.7. The Animation Control Panel 
 

               
Play button: Devreyi çalıştırır. 

 
Step button: Devreyi adım adım çalıştırır. 

 
Pause button: Devrenin çalışmasına ara verir. 

 
Stop button: Devrenin çalışmasını durdurur. 
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UYGULAMA FAALİYETİ 
 

İşlem Basamakları Öneriler 
Ø Yeni bir tasarım dosyası açınız. Ø Bu işlem için ilgili araç çubuğunu ve 

dosya menüsünü kullanınız. 
Ø Tasarım dosyanızı arzu ettiğiniz 

bir isimde kaydediniz. 
Ø  

Ø Çalışma alanının orijin 
noktasını değiştiriniz. 

Ø  

Ø File Toolbar, View Toolbar, 
Edit Toolbar ve Design Toolbar 
araç çubuklarını gizleyiniz ve 
ardından görünür yapınız. 

Ø View→Toolbars komutunu 
kullanabilirsiniz. 

Ø Edit Design Properties 
penceresini açınız ve istediğiniz 
numaraları giriniz. 

Ø Design→Edit Design Properties komutunu 
kullanabilirsiniz. 

Ø Edit Sheet Properties 
penceresini açınız ve istediğiniz 
numaraları giriniz. 

Ø Design→Edit Sheet Properties komutunu 
kullanabilirsiniz. 

Ø Edit Design Defaults 
penceresini açınız ve tasarım 
alanı renklerini ve animasyon 
renklerini değiştiriniz. 

Ø Template→Set Design Defaults komutunu 
kullanabilirsiniz. 

Ø Graph Colour Configuration 
penceresini açınız ve grafik 
renklerini değiştiriniz. 

Ø Template → Set Graph Colours komutunu 
kullanabilirsiniz. Gözünüze en uygun ve 
en uyumlu renkleri seçmeye çalışınız. 

Ø Edit Global Text Styles 
penceresini açınız ve metin 
biçimlerini değiştiriniz. 

Ø Template → Set Graphics Styles 
komutunu kullanabilirsiniz. 

Ø Environment Configuration 
penceresini açınız ve ortam 
değişkenlerini değiştiriniz. 

Ø Bilgisayarınız için en uygun değerleri 
belirlemeye çalışınız.  

 
 

UYGULAMA FAALİYETİ 



 

 37 

 
ÖLÇME VE DEĞERLENDİRME 
 

Bu bölümde 1 nu’lu öğrenme faaliyetinde anlatılan konular hakkında bilginizi ve 
yeteneğinizi ölçmek amacıyla çoktan seçmeli sorular sorulacaktır. Soruları duyarlılıkla 
yanıtlamanız önerilir. 
 
ÖLÇME SORULARI 

1. Yeni bir tasarım alanı açmak için aşağıdaki işlemlerden hangisi yapılır?  

A) File → New Design  
B) File → Load Design  
C) File → Save Design  
D) File → Save Design As 

 
2. Aşağıdaki eylemlerden hangisi çalışma alanı görüntüsü büyüklüğünün değiştirilmesinde 
kullanılmaz? 

 
A) View → Zoom in   C) View → Zoom All 
B) View → Zoom out   D) View → Pan 

 
3. Tasarım alanına ismini bildiğimiz bir elemanı çağırmak için aşağıdaki işlemlerden hangisi 
yapılır? 

 
A) Library → Make Symbol  C) Library → Make Device 
B) Library → Pick Device/Symbol  D) Library → Compile to Library  

 
4. Tasarım alanına yerleştirilen elemanlara sembol numaralarını sırasıyla vermek için 
aşağıdaki işlemlerden hangisi yapılır? 

 
A) Tools → Real Time Snap 
B) Tools → Wire Auto Router 
C) Tools → Real Time Annotation 
D) Tools → Model Compiler 

 
5. Üzerinde çalışılan tasarım alanına başlık ve isim vermek için  aşağıdaki işlemlerden 
hangisi yapılır? 

 
A) Design → Edit Design Properties 
B) Design → Edit Sheet Properties  
C) Design → New Sheet  
D) Design → Goto Sheet 

ÖLÇME VE DEĞERLENDİRME 
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6. Tasarım alanında bulunan grafiğe izleme noktası ( veya noktaları) eklemek için aşağıdaki 
işlemlerden hangisi yapılır? 

 
A) Graph → Add Trace 
B) Graph → Edit Graph 
C) Graph → Operating Point 
D) Graph → Simulate Graph 

7. Ana Modlar araç çubuğunda yer alan yandaki simgenin (  ) işlevi nedir? 

A) Eleman seçmek ve düzenlemek için kullanılır. 
B) Tasarım alanına eleman çağırmak ve elemanları listelemek için kullanılır. 
C) Terminal eklemek için kullanılır. 
D) Eleman ayağı eklemek için kullanılır. 

8. Gadgets araç çubuğunda yer alan yandaki simgenin ( ) işlevi nedir? 

A) Eleman seçmek ve düzenlemek için kullanılır. 
B) Tasarım alanına eleman çağırmak ve elemanları listelemek için kullanılır. 
C) Terminal  eklemek için kullanılır. 
D) Eleman ayağı eklemek için kullanılır. 

9. Gadgets araç çubuğunda yer alan yandaki simgenin ( ) işlevi nedir? 

A) Kullanıcı kütüphanesinde VSM cihazları listeler.  
B) Kullanıcı kütüphanesinde sinyal üreteçleri listeler.  
C) Devreye Voltaj Probu eklemek için kullanılır. 
D) Devreye Akım Probu eklemek için kullanılır. 

10. Ana Modlar araç çubuğunda yer alan yandaki simgenin ( ) işlevi nedir? 

A) Çoklu yol çizmek için kullanılır. 
B) Entegre devre oluşturmak için kullanılır.  
C) Birleştirme noktası koymak için kullanılır. 
D) Eleman seçmek ve düzenlemek için kullanılır. 
 

 
DEĞERLENDİRME 

 
Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek 

kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt ettiğiniz 
sorularla ilgili konuları faaliyete dönerek tekrar inceleyiniz. 

 
Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz. 
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ÖĞRENME FAALİYETİ-2 
 
 
 
Uygun ortam sağlandığında analog test cihazlarını ve devre elemanlarını tanıyarak, 

devre içine yerleşimini yapabileceksiniz. 
 
 
 
Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır: 

Ø Bir elektronik laboratuvarında bulunan analog test cihazlarının isimlerini ve 
hangi amaçla kullanıldıklarını araştırınız. 

Ø Bir elektronik laboratuvarında bulunan analog elemanların isimlerini ve hangi 
amaçla kullanıldıklarını araştırınız. 

2. ANALOG DEVRELERLE ÇALIŞMAK 
 
Minimum ile maksimum değerler arasında çok sayıda değer alabilen sinyalleri işleyen 

devrelere analog devreler denir. Direnç, kondansatör, transistör gibi elemanlardan kurulan 
güç kaynağı, yükselteç, dimmer gibi devreler analog devrelerdir. 

 
Bu bölümde ISIS simülasyon programında analog test aygıtlarının tanıtılması, analog 

devre elemanlarının yerleştirilmesi, analog devreye test aygıtlarının yerleştirilmesi konuları 
işlenecektir. 
 
2.1. Menüdeki Analog Test Aygıtları ve Kullanılması 
 

ISIS programının elektronik laboratuvarında 12 tane ölçü aleti ve cihaz 
bulunmaktadır. Bunlardan 4 tanesi analog test cihazı, 8 tanesi dijital test cihazıdır. 

 
Şimdi analog test cihazlarını inceleyeceğiz. 
 

2.1.1. Ampermetre 
 

Ampermetreler analog veya dijital olarak iki ayrı türde kullanılabilen ölçü aletleridir. 
Devreden geçmekte olan akımı ölçer. Yapım amaçlarına göre bir kaç Miliamper'den yüzlerce 
Amper'e kadar ölçüm yapabilir. Bu ölçüm DC veya AC akım ölçümü olabilmektedir. 

 
ISIS programı kütüphanesinde birçok ampermetre bulunmaktadır. Ölçüm yapacağınız 

devrede en uygun olanı hangisi ise kütüphaneden o ampermetreyi çağırmalısınız. 

ÖĞRENME FAALİYETİ–2 

AMAÇ 

ARAŞTIRMA 
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Şekil 2.1: DC ampermetre 

2.1.2. Voltmetre 
 

Voltmetreler gerilim (potansiyel fark) ölçmeye yarayan cihazlardır. Devreye paralel 
bağlanırlar. Temel olarak DC voltaj ve AC voltaj ayrı ölçülürler. 

 
ISIS programı kütüphanesinde birçok voltmetre bulunmaktadır. Ölçüm yapacağınız 

devrede en uygun olanı hangisi ise kütüphaneden o voltmetreyi çağırmalısınız. 
 

 
Şekil 2.2: DC voltmetre 

2.1.3. Osilaskop 
 

Elektriksel işaretlerin ölçülüp değerlendirilmesinde kullanılan aletler içinde en geniş 
ölçüm olanaklarına sahip olan osilaskop cihazıdır. Osilaskop, işaretin dalga şeklinin, 
frekansının ve genliğinin aynı anda belirlenebilmesini sağlar. 

 

 
Şekil 2.3: Osilaskop 

 
Osilaskop tasarım alanına çağrıldıktan sonra ölçüm yapılacak noktalara osilaskobun 

bağlantısı yapılır. İki kanal birden kullanılabilir. Bağlantı işlemi bittikten sonra devre 
çalıştırılırsa ekrana osilaskop paneli gelir. Osilaskop panelinden istenen ayarlar yapılır. 
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Şekil 2.4: Osilaskop önpaneli 

 
2.1.4. Sinyal Jeneratörü 

 
Sinyal jeneratörü devrenize uygulayacağınız sinüsoidal, kare dalga ya da üçgen dalga, 

testere dişi biçiminde sinyaller üretir. 

 
Şekil 2.5: Sinyal jeneratörü 

 
Sinyal jeneratörü tasarım alanına çağrıldıktan sonra ölçüm yapılacak noktalara Sinyal 

jeneratörünün bağlantısı yapılır. Bağlantı işlemi bittikten sonra devre çalıştırılırsa ekrana 
Sinyal jeneratörünün ön panel görüntüsü gelir. Devrenizin simülasyonu esnasında sinyal 
jeneratörü ile ilgili ayarları ön panel aracılığı ile yapabilirsiniz. 

 

 
Şekil 2.6: Sinyal jeneratörü önpaneli 

 
2.2. Analog Devre Elemanlarının Yerleştirilmesi ve Düzenlenmesi 

 
ISIS programı simülasyon ve analiz programları içinde kütüphanesi en zengin olan 

programlardan biridir. 
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Bu bölümde ISIS programının kütüphanesinden analog devre elemanlarının çağrılması 
ve yerleştirilmesi uygulamalı olarak anlatılacaktır. 

 
2.2.1. Tasarım Alanına Eleman Çağrılması 

Ø İşlem Adımları  

• Yeni bir tasarım alanı açınız. 
• Elemanlar kutusunun ( Devices) sol üst kısmında bulunan P butonuna 

tıklayınız. ( ISIS eleman kütüphanesi olan Pick Devices penceresi 
açılacaktır.) 

• Açılan pencereden Libraries bölümünden ACTIVE kütüphanesini 
bulunuz ve fare imleciyle üzerine gelip bir kere sol tıklayınız. Pencerenin 
alt kısmında bulunan Objects bölümünde bu kütüphane içinde bulunan 
elemanlar listelenecektir. 

• Bu elemanlardan “Battery” elemanının üzerine geliniz ve farenin sol 
tuşuyla çift tıklayınız.   

• Bu işlemi yaptıktan sonra ISIS programı ana penceresinde bulunan 
Devices kutusuna bakınız. Battery elemanı kütüphaneden çağrılmıştır. 

• Aynı kütüphanede bulunan “SWITCH”, “CAPACITOR” elemanlarını 
çağırınız. 

• Tekrar Libraries bölümünden Device kütüphanesini bulunuz ve bu 
kütüphaneden  “RES” elemanını çağırınız. 

• Pick Devices penceresini kapatınız. 
• ISIS programı ana penceresinde bulunan Devices kutusunda bulunan 

Battery elemanının üzerine tıklayarak seçili hale getiriniz. (Seçilen 
elemanın sembolü tasarım ön görünüş kısmında görünmelidir ) 

• Fare imlecini tasarım alanına götürerek herhangi bir yere sol 
tıkladığınızda Battery elemanı tasarım alanına taşınmış olacaktır. 

• Aynı yöntemi kullanarak diğer elemanları da tasarım alanına taşıyınız. 
• Çağıracağınız elemanın ismini biliyorsanız Library→Pick Device/ 

Symbol seçeneklerini çalıştırınız. Pick/Replace Library Part penceresi 
açılacaktır. ‘‘Name or text to search for’’ yazısının altındaki kutuya 
elemanın ismini yazınız. Mathcs bölümünde, bu elemanın ismi ve hangi 
kütüphanede olduğu görülür. OK butonuna basarak elemanı malzeme 
kutusuna çağırabilirsiniz. 

 
2.2.2. Tasarım Alanında Devre Oluşturulması 
 

2.2.1’de tasarım alanına taşıdığınız elemanlarla devre oluşturacağız.  
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Ø İşlem Adımları 

• Fare imlecini tasarım alanında bulunan Battery elemanının üzerine 
götürünüz ve bir kere sağ tıklayınız. Elemanın rengi kırmızı olacaktır 
(Böylece tasarım alanındaki elemanı seçili hale getirdiniz.). 

• Eleman seçili hale geldikten sonra, fare imleci yine elemanın üzerinde 
iken bir defa sol tıklayınız. Farenin sol tuşunu bırakmadan bataryayı 
devrenizi kurmak istediğiniz yere taşıyınız.  

• Elemanı taşımak istediğiniz yere gelince farenin sol tuşunu bırakınız.  
• İşlemi sonlandırmak için  fare imlecini tasarım alanında boş bir alana 

götürünüz ve bir kere sağ tıklayınız (Böylece tasarım alanındaki bir 
elemanı istediğiniz yere taşımış oldunuz.). 

• Aynı yöntemi kullanarak bütün elemanları Şekil 2.7’de görüldüğü gibi 
yerleştiriniz. 

• Elemanlar arası bağlantı yapmak için fare imlecini bağlantı yapmak 
istediğiniz elemanın pini üzerine götürünüz. Göstergenin ucunda x işareti 
oluşunca bir kere sol tuşa tıklayınız ve bırakınız. 

• Bağlantı yapacağınız diğer elemanın pini üzerine gidiniz. Yine x işareti 
oluşunca bir kere sol tıklayınız ve bırakınız. Böylece iki eleman arasında 
bağlantı yapmış oldunuz. 

• Elemanlar arası bağlantı yapılırken Dizayn Araçlar çubuğunda bulunan 
 (Enable/Disable wire auto-router) butonunu aktif hale getiriniz. 

Bilgisayarınız bağlantı yollarını otomatik olarak kendisi birleyecektir. 
• Play butonuna basarak devrenizi çalıştırınız ( Devre elemanları Default 

değerindedir). 
• Devrede bulunan anahtarın üzerine farenin sol tuşuyla bir defa 

tıkladığınızda anahtar konum değiştirecektir. 
 

 
Şekil 2.7: Kondansatörün şarj devresi 

 
• Devredeki akım yollarını görmek ve gerilim hattını renklendirmek için 

sırasıyla ‘‘System→Set Animation Options’’ seçeneklerini aktif hale 
getiriniz. Karşınıza gelen iletişim penceresinden Show Wire Voltage by 
Colour ile Show Wire Current With Arrows seçeneklerini aktif hale 
getiriniz. 
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2.2.3. Bir Devredeki Elemanın Değerinin veya Sembol İsminin Değiştirilmesi 
 
2.2.2’de oluşturduğunuz devredeki elemanların değerini veya sembol isimlerini 

aşağıdaki işlem basamaklarını takip ederek değiştiriniz. 

Ø İşlem Adımları 

• Main Modes araç çubuğu üzerinde bulunan  (Instant edit mode) 
butonuna sol tıklayınız. 

• Fare imlecini tasarım alanında bulunan direncin üzerine götürünüz ve bir 
kere sol tıklayınız. 

• Edit Component penceresi açılacaktır ( Şekil 2.8).  
• Component Reference kutusundan direncin sembolünü R2 yapınız. 
• Resistance kutusundan direncin değerini 5K yapınız. 
• Edit component penceresinde bulunan Hidden kutuları onaylarsanız 

elemanın sembolü ve/veya değeri tasarım alanında gözükmez. 
• Edit component penceresinde bulunan Edit all properties as text  

seçeneği sayesinde istediğiniz değişiklikleri text olarak yapabilirsiniz. 
• Edit Component penceresini kapatınız. 
•  (Instant edit mode) Butonu aktif iken kondansatör üzerine sol 

tıklayınız. Kondansatör için açılan Edit Component penceresinden 
kondansatörün sembolünü C2, kapasite değerini 100μF olarak 
değiştiriniz. 

 

 
Şekil 2.8: Direnç için edit component penceresi 

 
• Aynı yöntemi uygulayarak bataryanın sembolünü E, değerini 15V 

yapınız. 
• Play butonuna basarak devrenizi çalıştırınız. 
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• Kondansatörün şarj olmasını izleyiniz. 
• Devrenizdeki gerilim hatlarını ve akım yollarını gözlemleyiniz. (2.2.2’ye 

bakınız.) 
 
2.2.4. Tasarım Alanında Bulunan Bir Elemanın Silinmesi 

Ø İşlem Adımları 

• Tasarım alanında bulunan bir elemanı seçili hale getiriniz. 
• Klavyeden Delete tuşuna basınız veya Edit Toolbar üzerinde bulunan 

       (Delete All Tagged Objects ) butonuna tıklayınız. Elemanınız 
silinecektir. 

• Silmek istediğiniz elemanın üzerine farenin sağ tuşuyla iki kere 
tıkladığınızda da eleman silinecektir. 

 
2.2.5. Tasarım Alanında Blok Oluşturmak Ve Oluşturulan Bloğun Taşınması 

Ø İşlem Adımları 

• Tasarım alanında blok oluşturmak istediğiniz bölgenin sol üst noktasına 
fare imlecini getiriniz. 

• Farenin sağ tuşuna basılı tutarak oluşturmayı düşündüğünüz bloğun sağ 
alt köşesine doğru sürükleyiniz. 

• Bitiş noktasına vardığınızda sağ tuşu bırakınız.  
• Oluşturduğunuz blok içindeki elemanlar ve yollar kırmızı rengi alır. 

Bloğun çerçevesi ise açık mavi renk olur. Böylece bloğu oluşturmuş 
oldunuz. 

• Oluşturduğunuz bloğu tasarım alanında istediğiniz yere taşımak için Edit 
Toolbar üzerinde bulunan   ( Move Tagged Objects ) butonuna 
tıklayınız. 

• Fare göstergenizi taşımak istediğiniz yere doğru sürükleyiniz. 
• Bloğu taşımak istediğiniz alana götürdükten sonra sol tıklayınız. Böylece 

bloğu taşımış oldunuz. 
 

2.3. Analog Devreye Test Aygıtlarının Bağlanması 
 

2.3.1. Analog Devrede Akım Ölçülmesi 

Ø İşlem Adımları 

• BATTERY, RES ve CAPACITOR elemanlarını tasarım alanına çağırınız. 
• ISIS programı ana penceresinde Tasarım Araç Çubuğunda bulunan  

(Virtual Instruments ) butonuna farenin sol tuşu ile bir kere tıklayınız. 
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Malzeme kutusunun ismi INSRUMENTS olarak değişecektir. İçeriğinde 
ise ISIS kütüphanesinde bulunan cihazların ve ölçü aletlerinin ismi yer 
alacaktır. Bunlardan  DC AMMETER’yi seçiniz. 

• Şekil 2.9’daki devreyi kurunuz. 
• DC güç kaynağınızın değerini 20V’a, sembolünü E olarak değiştiriniz. 
• Direnç değerinizi 1kΩ yapınız. 
• Kondansatör kapasitesini 1000μF, çalışma voltajını 25V olarak 

ayarlayınız. 
 

 
Şekil 2.9: Akım ölçmek 

 
•  (Instant edit mode ) butonu aktif iken ampermetrenin üzerine 

tıklayınız. Karşınıza gelen Edit Component penceresinden ampermetreyi 
microampers olarak ayarlayınız. 

• Play butonuna basarak devrenizi çalıştırınız ve ampermetreyi 
gözlemleyiniz. 

• Devrenizdeki elemanların değerlerini istediğiniz değerlerde değiştirerek 
ampermetreyi tekrar gözlemleyiniz. 

 
2.3.2. Analog Devrede Gerilim Ölçülmesi 

Ø İşlem Adımları 

• Tasarım alanına Şekil 2.10’daki devreyi kurunuz.(2.2.2’ ye bakınız) 
• Voltmetre olarak DC VOLTMETTER’i seçiniz. 

 

 
Şekil 2.10: Gerilim ölçmek 
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• Devrenizi çalıştırınız. Voltmetreyi ve ampermetreyi gözlemleyiniz. 
• Devrenizdeki elemanların değerlerini değiştirerek voltmetreyi ve 

ampermetreyi tekrar gözlemleyiniz. 
 

2.3.3. Osilaskopla Yarım Dalga Doğrultmaç Devresinin Giriş-Çıkış Sinyal 
Şekillerinin Gözlemlenmesi 

Ø İşlem Adımları 

• Device kütüphanesinden “RES, TRAN-2PS, 1N4001 ” elemanlarını 
çağırınız. 

• Osilaskobu ve AC Voltmetreyi tasarım alanına çağırınız. 
• Gadgets araç çubuğunda bulunan  ( Generatör ) butonuna sol 

tıklayınız. Malzeme kutusuna getirilen jeneratörlerden SINE olanını 
seçiniz. 

• Gadgets araç çubuğunda bulunan   ( Inter-sheet Terminal ) butonuna 
sol tıklayınız. Malzeme kutusuna getirilen terminallerden GROUND 
elemanını seçiniz. 

• Şekil 2.11’deki devreyi kurunuz. 
 

 
Şekil 2.11: Yarım dalga doğrultmaç devresi 

 
•  (Instant edit mode) düzenleme moduna giriniz ve tasarım alanında 

bulunan SINE elemanını seçiniz. Şekil 2.12’deki ayarları yapınız.  
• Tekrar tasarım alanına dönünüz ve düzenleme modundayken 

transformatörü seçiniz Karşınıza gelen düzenleme penceresinden Şekil 
2.13’teki ayarları yapınız. 

• ISIS programında transformatörün çalışması için primerine bir direnç 
bağlanması zorunludur. Bu direncin değeri 1µΩ’dur. 
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Şekil 2.12: SINE jeneratörünün düzenleme penceresi 

 

 
Şekil 2.13: Transformatör düzenleme penceresi 

 
• Play butonuna basarak devrenizi çalıştırınız. 
• Devre çalışmaya başlayınca osilaskobun önpanel görüntüsü ekrana 

gelecektir. Osilaskop ayarlarını Şekil 2.14’teki gibi ayarlayınız. 
 

 
Şekil 2.14: Osilaskobun önpanel görüntüsü 

 
• Eğer osilaskobun önpanel görüntüsü ekrana gelmezse Debug→VSM 

Oscillocope seçeneklerini çalıştırınız. 
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2.3.4. 7812 Entegresiyle Güç Kaynağı Devresinin Yapılması 

Ø İşlem Adımları 

• Şekil 2.15’te görülen elemanları malzeme kutusuna çağırınız. 
 

 
Şekil 2.15: Malzeme kutusu 

 
1. Şekil 2.16’daki devreyi tasarım alanına kurunuz. 
2.  (Instant edit mode) düzenleme moduna giriniz ve tasarım alanında bulunan 

SINE elemanını seçiniz. Açılan düzenleme penceresinden sinyalin ismini VSIN, 
RMS değerini 220V ve frekansını 50Hz olarak ayarlayınız. (2.3.3’e bakınız. ) 

 

 
Şekil 2.16: 7812 Entegresi ile yapılan güç kaynağı devresi 

 
• Play butonuna basarak devrenizi çalıştırınız. 
• Devrenin çıkışına bağlanan DC voltmetre 12V gösterecektir. 

 



 

 50 

2.3.5. Öngerilimli Seri Kırpıcı Devresinin Yapılması 

Ø İşlem Adımları 

• Kütüphaneden 1N4001, RES, CELL, ALTERNATOR elemanlarını 
çağırınız. 

• Şekil 2.17’deki devreyi kurunuz. 
• Düzenleme modundayken alternatörün genliğini 12V, frekansını 100Hz 

olarak ayarlayınız. 
 

 
Şekil 2.17: Öngerilimli seri kırpıcı devresi 

 
• Yine düzenleme modundayken DC gerilim kaynağının sembolünü E, 

gerilim değerini 5V olarak ayarlayınız.  
• 5V üzerine sol tıklayınız. Açılan Edit Component Value penceresinden 

Style butonunu aktif hale getiriniz Şekil 2.18’deki düzenlemeyi yapınız. 
Yazının boyutu büyüyecektir (Edit Component Value Style 
penceresinden istediğiniz elemanın stil ayarlarını yapabilirsiniz. ). 

• Direncin değerini 1KΩ yapınız. 
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Şekil 2.18: Eleman değerlerinin stil ayarlarının yapılması 

 
• Devrenizi çalıştırınız. Devrenizin giriş-çıkış sinyallerini osilaskoptan 

gözlemleyiniz. (Şekil 2.19) 
 

 
Şekil 2.19: Osilaskobun önpanel görüntüsü 

 
• Seri kırpıcı devrelerde çıkış sinyali devreye bağlanan DC gerilim 

kaynağının ve diyodun değerine ve yönüne bağlı olarak değişir. 
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ÖLÇME VE DEĞERLENDİRME 

 
Bu bölümde 2 nu’lu öğrenme faaliyetinde anlatılan konular hakkında bilginizi ve 

yeteneğinizi ölçmek amacıyla çoktan seçmeli sorular sorulacaktır. Soruları duyarlılıkla 
yanıtlamanız önerilir. 
 
ÖLÇME SORULARI 

1. Devredeki akım yollarını görmek için aşağıdaki işlemlerden hangisi yapılır?  

A) System → Set Animation Options→ Show Voltage& Current on Probes?  
B) System→ Set Animation Options → Show Logic State of  Pins? 
C) System→ Set Animation Options → Show Wire Voltage by Colour? 
D) System→ Set Animation Options→ Show Wire Current with Arrows? 
 

2. Aşağıdaki seçeneklerden hangisi tasarım alanında bulunan bir elemanı silmek için 
kullanılmaz? 

 
A) Eleman seçili hale getirilir. Klavyeden Delete tuşuna basılır. 
B) Eleman seçili hale getirilir. Klavyeden Enter tuşuna basılır. 
C) Eleman seçili hale getirilir. Edit Toolbar araç çubuğu üzerinde bulunan 
Delete All Tagged Objects Butonuna basılır. 
D) Elamanın üzerine farenin sağ tuşuyla çift tıklanır. 

 
3. Aşağıda verilen cihazlardan hangisi analog test cihazı değildir? 

 
A) Pattern Jeneratörü  C) Osilaskop 
B) Sinyal Jeneratörü              D) DC Voltmetre 

 
4. ENERATORS malzeme kutusunda bulunan SINE jeneratörü hangi amaçla kullanılır? 

 
A) Devrenin girişine pals vermek için kullanılır. 
B) Devrenin girişine istediğimiz frekansta tetikleme sinyali vermek için 
kullanılır. 
C) Devrenin girişine sabit genlikte DC sinyal vermek için kullanılır. 
D) Devrenin girişine istenen genlik ve frekansta AC sinyal vermek için 
kullanılır. 

 
5. Aşağıda verilen seçeneklerden hangisi ISIS programında kullanılan sinyal jeneratörünün 
özelliklerinden değildir? 

 
A) Sinüsoidal, testere dişi, üçgen dalga ve kare dalga sinyal üretir. 
B) Genlik ve frekans modülasyonu girişleri vardır. 
C) Çıkış sinyali frekansı 0-20MHz aralığındadır. 
D) Çıkış sinyal genliği 0-12V aralığındadır. 

ÖLÇME VE DEĞERLENDİRME 
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6. Gadgets araç çubuğunda yer alan  butonu aktif hale getirildiğinde açılan malzeme 
kutusunda aşağıdaki malzemelerden hangisi yer almaz? 

A) Sinyal jeneratörü 
B) Pattern Jeneratörü 
C) Alternatör 
D) Virtual terminal 

7. Tasarım alanında bulunan bir eleman değerinin sitil ayarlarını yapmak için aşağıdaki 
işlemlerden hangisi yapılır? 

A)  → Değerin üzerine sol tıklanır→Edit Component Value→Style 
B)  → Elemanın üzerine sol tıklanır→Edit Component Value→Style 
C) .→ Elemanın üzerine sol tıklanır→Edit Component Value→Style 
D) .→ Değerin üzerine sol tıklanır→Edit Component Value→Style 

8. Tasarım alanında oluşturulan bloğu taşımak için aşağıdaki butonlardan hangisi kullanılır? 

A)                   B)               C)                   D)   

9.  ( GROUND ) elemanı aşağıdaki malzeme kutularından hangisinin içinde  

yer alır? 

A)                  B)                 C)                       D)         
 

10. Kütüphaneden RES elemanını malzeme kutusuna çağırmak için aşağıdaki işlevlerden 
hangisi yapılır? 

A)  → ACTİVE→RES 
B)  → DEVICE→RES   
C)  → ANALOG→RES 
D)  → RESISTORS→RES 

 
DEĞERLENDİRME 

 
Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek 

kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt ettiğiniz 
sorularla ilgili konuları faaliyete dönerek tekrar inceleyiniz. 

 
Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz. 
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ÖĞRENME FAALİYETİ-3 
 
 
 
Uygun ortam sağlandığında basit elektrik kanunlarının ispatlandığı devreleri, 

transistorlü ve op-amplı devreleri tasarlayarak, çalışmalarına ait sonuçları 
değerlendirebileceksiniz. 

 
 
 
Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır: 

Ø Ohm kanunlarını ve kirşof kanunlarını araştırınız. 
Ø Transistör çeşitlerini ve çalışma prensiplerini araştırınız. 
Ø Op-amplı devrelerin çeşitlerini ve çalışma prensiplerini araştırınız. 

3. ANALOG DEVRE UYGULAMALARI 
 
3.1. Ohm ve Kirşof Kanunlarının Isıs Programı ile İspatlanması 
 

Elektrik-Elektronik devrelerinin kavranmasında son derece önemli olan ohm kanunu, 
Kirşof akım ve gerilim kanunlarını ISIS simülasyon programını kullanarak yapabiliriz. ISIS 
simülasyon programında malzemelerin değerlerini kolaylıkla değiştirebildiğimiz için bu 
deneyleri çok geniş değerler aralığında tekrarlamak ve böylece konuları tam manasıyla 
kavramak mümkündür. 

 
Bir elektrik devresinde akım,voltaj ve direnç arasında bir bağlantı mevcuttur. Bu 

bağlantıyı veren kanuna Ohm Kanunu adı verilir. 
 
Kirşof Akım, kanununa göre bir elektrik devresinde bir noktaya giriş yapan akımların 

toplamı o noktadan çıkan akımların toplamına eşittir.  
 
Kirşof Gerilim, kanununa göre bir elektrik devresinde seri bağlı dirençlere düşen 

gerilimlerin toplamı devreye uygulanan gerilime eşittir. 
 

3.1.1. Ohm Kanunu Deneyinin Yapılması  

Ø İşlem Adımları 

• Şekil 3.1’de görülen devreyi kurunuz. 
• Bataryanın değerini 10V, direncin değerini 6Ω olarak ayarlayınız. 

ÖĞRENME FAALİYETİ–3 

AMAÇ 

ARAŞTIRMA 



 

 55 

• Play butonuna basarak devrenizi çalıştırınız. Ampermetre ve 
voltmetredeki değerleri okuyarak bir yere kaydediniz. 

• Direnç değeri 6 Ω olarak sabit iken, devreye uygulanan gerilimi 9V 
olarak tanımlayınız. 

• Play butonuna basarak devrenizi çalıştırınız. Ampermetre ve 
voltmetredeki değerleri okuyarak bir yere kaydediniz. 

• Bataryanın değerini 10V’da sabit tutarak devredeki direnci 8Ω olarak 
tanımlayınız. 

• Play butonuna basarak devrenizi çalıştırınız. Ampermetre ve 
voltmetredeki değerleri okuyarak bir yere kaydediniz. 

• Kaydettiğiniz değerlere bakarak devreye uygulanan gerilimle devreye 
bağlanan direncin değerlerine bağlı olarak akımın nasıl değiştiğini 
gözlemleyiniz. 

 
Şekil 3.1: Ohm kanunu deneyi 

 
3.1.2. Kirşof Akım Kanunu Deneyinin Yapılması 

Ø İşlem Adımları 

• Şekil 3.2’de verilen devreyi kurunuz. 
• Bataryanın değerini 10V, Dirençlerin değerini 5Ω, 6Ω, 7Ω, 8Ω, olarak 

tanımlayınız. 
• Devrenizi çalıştırınız. Ampermetreden okuduğunuz değerleri bir yere 

kaydediniz. 
• Bataryanın değerini 15V olarak tanımlayınız. 
• Devrenizi çalıştırınız. Ampermetreden okuduğunuz değerleri bir yere 

kaydediniz. 
• Bataryanın değeri 10V’da iken direnç değerlerini 1KΩ, 3KΩ, 5KΩ ve 

7KΩ olarak tanımlayınız. 

 
Şekil 3.2: Kirşof akım kanunu deneyi 
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• Devrenizi çalıştırınız. Ampermetreden okuduğunuz değerleri bir yere 
kaydediniz. 

• Kaydettiğiniz değerlere bakarak devreye uygulanan gerilimle devreye 
bağlanan direncin değerlerine bağlı olarak akımın nasıl değiştiğini 
gözlemleyiniz. 

 
3.1.3. Kirşof Gerilim Kanunu Deneyinin Yapılması 

Ø İşlem Adımları 

• Tasarım alanında Şekil 3.3’te verilen devreyi kurunuz. 
• Bataryanın değerini 30V, Dirençlerin değerini 10Ω, 20Ω, 25Ω, olarak 

tanımlayınız. 

 
Şekil 3.3: Kirşof gerilim kanunu deneyi 

 
• Devrenizi çalıştırınız. Voltmetrelerden okuduğunuz değerleri bir yere 

kaydediniz. 
• Bataryanın değerini 40V olarak tanımlayınız. 
• Devrenizi çalıştırınız. Voltmetrelerden okuduğunuz değerleri bir yere 

kaydediniz. 
• Bataryanın değeri 30V’da iken direnç değerlerini 5KΩ, 10KΩ, ve 15KΩ 

olarak tanımlayınız. 
• Devrenizi çalıştırınız. Voltmetrelerden okuduğunuz değerleri bir yere 

kaydediniz. 
• Kaydettiğiniz değerlere bakarak seri bağlı farklı değerlerdeki dirençlerin 

devreye uygulanan gerilimi nasıl paylaştıklarını gözlemleyiniz. 
 

3.2. Transistörlü Devre Tasarımı ve Analizi 
 
Transistör en basit şekliyle küçük bir akımla daha büyük bir akımın kontrol edilmesini 

sağlayan yarı iletken bir elemandır. Bu sayede yükseltme ve kontrol işlemleri 
yapılabilmektedir. 
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3.2.1. NPN Tipi Transistörle Yapılan Emiteri Ortak Yükselteç Devresi 
Tasarlanması 

Ø İşlem Adımları 

• Şekil 3.4’teki devreyi kurunuz. 
• Devreyi çalıştırınız. 

 
Şekil 3.4: Emiteri ortak transistorlü yükselteç devresi 

 
• Sinyal jeneratörü önpanelini Şekil 3.5’teki gibi ayarlayınız. 

 

 
Şekil 3.5: Sinyal jeneratörünün önpanel görüntüsü 

 
• Osilaskop ayarlarını Şekil 3.6’daki gibi ayarlayınız. 

 

 
Şekil 3.6: Osilaskobun önpanel görüntüsü 
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• Osilaskop ekranı gözlemleyiniz. ( Üstteki sinyal giriş sinyalidir, alttaki 
sinyal ise çıkış sinyalidir. ) 

• Osilaskop ekranında da görüldüğü gibi girişteki sinyal çıkışta 
yükseltilmiştir. 

• Devredeki direnç değerlerini değiştirerek osilaskoptaki dalga şekillerini 
gözlemleyiniz. 

 
3.3. Opamplı Devre Tasarımı ve Analizini Yaparak Sonuçların 
Değerlendirilmesi  

 
3.3.1. Opamplı Alçak Geçiren Filtre Devresinin Tasarım Alanında Grafiğinin 
Oluşturulması (Frekans Responsu-BGF) 

Ø İşlem Adımları 

• Şekil 3.7’deki devreyi kurunuz. 
• Gadgets araç çubuğunda bulunan ( Generator ) butonuna tıklayınız. 

Açılan sinyal çeşitleri arasından SINE sinyalini seçiniz. SINE sinyalinin 
devre bağlantısını yapınız. 

•  ( Instant edit mode) Düzenleme moduna giriniz. SINE üzerine sol 
tıklayınız. İsmini Vg olarak değiştiriniz. Amplitude değerini 10V ve 
Frekansını 1MHz olarak ayarlayınız. 

• Çıkışta bulunan çıkış probunu ise Gadgets araç çubuğunda bulunan  
(Voltage Probe) düğmesi ile oluşturunuz. Düzenleme moduna giriniz ve 
ismini Vo olarak değiştiriniz. 

 
Şekil 3.7: Alçak geçiren filtre devresi 

 
• Gadgets araç çubuğu üzerinde bulunan  ( Simulation Graph ) 

düğmesine tıklayınız. Açılan malzeme kutusundan  FREQUENCY grafik 
çeşidini seçiniz. 

• Fare imlecini tasarım alanına götürünüz. Grafiği oluşturmayı 
düşündüğünüz yere sol tıklayınız ve sol tuşa basılı tutarak bir dikdörtgen 
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oluşturunuz. Bitiş noktasına geldiğinizde sol tuşu bırakınız. İçi boş olan 
bir grafik elemanı tasarım alanınızda oluşacaktır ( Şekil 3.8 ). 

 

 
Şekil 3.8: Frekans Responsu grafiği oluşturmaya başlama 

 
• Graph→Add Trace seçeneklerini çalıştırınız. Açılan Add Phasor Trace 

penceresinden Probe 1 aşağıya açılır kutudan Vg’yi seçiniz ve OK 
butonuna basınız (Şekil 3.9). 

• Tekrar Graph→Add Trace seçeneklerini çalıştırınız. Yine Probe 1 
aşağıya açılır kutudan Vo’yu seçiniz ve OK butonuna basınız. 

 

 
Şekil 3.9: Add phasor trace penceresi 

 
• Bu işlemleri yaparak grafiğimizde göstermek istediğimiz sinyalleri 

belirlemiş olduk. Grafiğimizin y eksenini oluşturmuş olduk (Şekil 3.10). 
 

 
Şekil 3.10: Grafikte y ekseninin oluşturulması 
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• Grafiğin sinyalleri göstermesi için Graph→Simulate Graph 
seçeneklerini çalıştırınız. Grafik Şekil 3.11’deki gibi olacaktır. Bu 
grafikte de frekans responsu görülmez. 

 

 
Şekil 3.11: Frekans responsu grafiği oluşturuluyor 

 
• Frekans Responsunu görebilmek için Graph→ Edit Graph seçeneklerini 

çalıştırınız. Şekil 3.12’de gösterildiği gibi düzenlemeleri yapınız. OK 
butonuna basarak işleminizi onaylayınız. 

 

 
Şekil 3.12: Edit transient graph penceresi 

 
• Graph→ Simulate Graph seçeneklerini çalıştırınız. Böylece frekans 

responsu grafiğini oluşturmuş oldunuz ( Şekil 3.13). 
 

 
Şekil 3.13: Frekans responsu grafiği 

 
• Templatte→ Set Graph Colours seçeneklerini çalıştırarak grafiğiniz ile 

ilgili renk ayarlarınızı kendiniz yapabilirsiniz. 
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• Graph→Frequency Response seçeneklerini çalıştırarak grafiği 
zoomlayınız. Pencerenin altındaki araç düğmelerini kullanarak grafiğin 
görüntüsünü istediğiniz gibi ayarlayabilirsiniz. 
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ÖLÇME VE DEĞERLENDİRME 
 

 
Bu bölümde 3 nu’lu öğrenme faaliyetinde anlatılan konular hakkında bilginizi ve 

yeteneğinizi ölçmek amacıyla çoktan seçmeli sorular sorulacaktır. Soruları duyarlılıkla 
yanıtlamanız önerilir. 
 
ÖLÇME SORULARI 
 
1. Osilaskop ile ölçüm yapılan bir devreyi çalıştırdığınızda osilaskop önpaneli ekrana 
gelmiyorsa aşağıdaki işlemlerden hangisi yapılır? 

 
A) Debug → VSM Ossillocope 
B) Source → VSM Ossillocope 
C) System→ VSM Ossillocope 
D) Tools→ VSM Ossillocope 

 
2.  ( Generatör ) butonu aktif hale getirildiğinde açılan malzeme kutusunda aşağıdaki 
elemanlardan hangisi bulunmaz? 

 
A) CELL  C) DCLOCK 
B) PULSE  D) DSTATE 

 
3. Edit Component penceresindeki Component Reference kutusunun yanındaki Hidden 
kutusu onaylanırsa aşağıdaki işlemlerden hangisi gerçekleşmiş olur? 

 
A) Elemanın değeri tasarım alanında görünmez. 
B) Elemanın ismi tasarım alanında görünmez. 
C) Elemanın modeli tipi tasarım alanında görünmez. 
D) Elamanın kendisi tasarım alanında görünmez. 

 
4. Tasarım alanında frekans responsu oluşturmak  için aşağıdaki butonlardan hangisi  
kullanılır? 
 

A)                   B)               C)                   D)   
 

5. Graph→Add Trace seçenekleri aşağıdaki işlevlerden hangisini gerçekleştirir? 
 

A) Tasarım alanında oluşturulan grafiğin simülasyon işlemini yeniler.  
B) Tasarım alanında oluşturulan grafiğin kontrolünü yapar. 
C) Tasarım alanında oluşturulan grafiğe izleme noktası veya noktaları ekler. 
D) Tasarım alanında bulunan grafiğin zamana bağlı olarak matematiksel 
verilerini bir dosya olarak kaydeder. 

ÖLÇME VE DEĞERLENDİRME 
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6. Aşağıdaki seçeneklerden hangisi tasarım alanında bulunan grafik ile ilgili renk ayarlarını  
yapmak için kullanılır? 

 
A) Graph→ Edit Graph 
B) Graph→ Simulate Graph 
C) Template→ Set Design Defaults 
D) Template→ Set Graph Colours 

 
7. Graph→Frequency Response seçenekleri aşağıdaki işlevlerden hangisini gerçekleştirir? 

 
A) Tasarım alanındaki grafikle ilgili bilgiler veren bir pencere açılır. 
B) Tasarım alanındaki grafiği zoomlar. 
C) DC işlem noktasını hesaplar. 
D) Tasarım alanındaki devrede değişiklik yapılmışsa ve bu değişiklik grafiği 
etkiliyorsa bu seçenek kullanılarak grafik tekrar oluşturulur. 

8. Yön araç çubuğunda yer alan yandaki simgenin ( ) işlevi nedir? 

A) Seçilen elemanı 90° sağa çevirir. 
B) Elemanın yatayda yansımasını alır. 
C) Elemanın dikeyde yansımasını alır. 
D) Seçilen elemanı 90° sola çevirir. 
 

 
 

DEĞERLENDİRME 
 
Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek 

kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt ettiğiniz 
sorularla ilgili konuları faaliyete dönerek tekrar inceleyiniz. 

 
Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz. 

 
 
 
 
 
 
 
 
 



 

 64 

 

ÖĞRENME FAALİYETİ-4 
 
 
 
Uygun ortam sağlandığında dijital test cihazlarını ve devre elemanlarını tanıyarak, 

devre içine yerleşimini yapabileceksiniz. 
 
 
 
Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır: 

Ø Bir dijital elektronik laboratuvarında bulunan cihazların ve test aygıtlarının 
isimlerini ve çalışma prensiplerini araştırınız. 

Ø Dijital devre elemanlarının isimlerini ve çalışma prensiplerini araştırınız. 

 

4. DİJİTAL DEVRELERLE ÇALIŞMAK 
 

Bu bölümde dijital test aygıtlarının tanıtılması ve kullanımının açıklanması, dijital 
devre elemanlarının yerleştirilmesi, bağlantı iletkenlerinin çizilmesi, dijital devreye test 
aygıtlarının bağlanması ve dijital devrenin çalıştırılması konuları uygulamalı olarak 
açıklanacaktır. 
 
4.1. Dijital Test Aygıtlarının Tanıtılması ve Kullanılmasının 
Açıklanması 
 
4.1.1. Pattern Jeneratörü  
 

VSM Pattern Jeneratörü; analog sinyal jeneratörünün dijitalidir.  VSM Pattern 
Jeneratörünün  1KB’a kadar hafıza desteği vardır ve 8 Bit’liktir.  
 

 
Şekil 4.1: Pattern jeneratörü 

 

ÖĞRENME FAALİYETİ–4 

AMAÇ 

ARAŞTIRMA 
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4.1.1.1. ISIS Programında Pattern Jeneratörünün Kullanılması 

Ø İşlem Adımları 

• Virtual Instruments düğmesini kullanarak, kullanıcı kütüphanesinde 
isimleri listelenen VSM cihazları içinden pattern jeneratörü üzerine 
tıklayınız. 

• Tasarım alanına Pattern jeneratörünü yerleştirmek istediğiniz yere farenin 
sol tuşuyla bir kere tıklayınız. Pattern jeneratörünü tasarım alanına 
yerleştirmiş oldunuz. 

• Şema üzerinde pattern jeneratörü ile ilgili gerekli bağlantıları yapınız. 
• Play butonuna tıklayarak devrenizi çalıştırınız.  

 
4.1.2. Lojik Analizör 
 

Dijital devrelerdeki lojik sinyallerin durumunu diyagram şeklinde gösterir. A1, A2, 
A8 uçları lojik devrede durumunu görmek istediğiniz noktalara bağlanır.  
 

 
Şekil 4.2: Lojik analizör 

 
4.1.2.1. ISIS Programında Lojik Analizörün Kullanılması 

Ø İşlem Adımları 

• Virtual Instruments düğmesini kullanarak, kullanıcı kütüphanesinde 
isimleri listelenen VSM Cihazları içinden Logic Analyser üzerine 
tıklayınız. 

• Tasarım alanına Lojik Analizörü yerleştirmek istediğiniz yere farenin sol 
tuşuyla bir kere tıklayınız. Lojik Analizörü tasarım alanına yerleştirmiş 
oldunuz. 

• Şema üzerinde Lojik Analizör ile ilgili gerekli bağlantıları yapınız. 
• Play butonuna basarak simülasyonu başlatınız. 
• Sinyalleri görüntüleyebilmek için Trigger Mode düğmesine basarak 

Armed ledinin yanmasını sağlayınız. Sinyallerinizi daha iyi 
görüntüleyebilmek için resulation ve zoom düğmelerini ayarlayınız. 
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4.1.3. Lojik Frekans Sayıcı (Counter Timer ) 
 

Lojik frekans sayıcı, CLK girişine bağlanan hattaki lojik sinyalin değişim sayısını 
ölçer. Ölçtüğü değeri ekranında dijital olarak gösterir. Lojik frekans sayıcı üzerinde bulunan 
CE girişi; Frekans sayıcımızın aktif etme pinidir. RST girişi ise sayıcımızı resetleme pinidir. 

 
Şekil 4.3: Lojik frekans sayıcı 

 
4.1.3.1. ISIS Programında Lojik Frekans Sayıcının Kullanılması 

Ø İşlem Adımları 

• Virtual Instruments düğmesini kullanarak, kullanıcı kütüphanesinde 
isimleri listelenen VSM cihazları içinden Counter Timer üzerine 
tıklayınız. 

• Tasarım alanına Counter Timer’ı yerleştirmek istediğiniz yere farenin sol 
tuşuyla bir kere tıklayınız. Lojik frekans sayıcıyı tasarım alanına 
yerleştirmiş oldunuz. 

• Şema üzerinde frekans sayıcı ile ilgili gerekli bağlantıları yapınız. 
• Play butonuna tıklayarak devrenizi çalıştırınız.  

 
4.1.4. Clock Üreteci 
 

Lojik devreler için istenen frekansta ve genlikte kare dalga sinyal üretmek için 
kullanılır. Clock üreteci üzerinde tek bir çıkış vardır ve bu çıkış kare dalga sinyalin 
uygulanacağı yere bağlanır. 

 
Şekil 4.4: Clock üreteci 

 
4.1.4.1. ISIS Programında Clock Üretecinin Kullanılması 

Ø İşlem Adımları 

• Active kütüphanesinden Clock üretecini Devices kutusuna çağırınız. 
• Device kutusunda yer alan Clock üzerine tıklayınız. 
• Tasarım alanına Clock üretecini yerleştirmek istediğiniz yere farenin sol 

tuşuyla bir kere tıklayınız. Üreteci tasarım alanına yerleştirmiş oldunuz. 
• Düzenleme modundayken üretecin frekansını ayarlayınız. 
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• Şema üzerinde Clock üretecini ile ilgili gerekli bağlantıları yapınız. 
• Play butonuna tıklayarak devrenizi çalıştırınız.  

 
4.1.5. Virtual Terminal ( VTerm ) 
 

Virtual terminal, seri iletişim arabirimidir. Seri data üretebilir ve alabilir, aldığı datayı 
istenen formatta gösterebilir. Bu datalar ASCII kod formatına uygun biçimde olmalıdır.  

 
Virtual terminal üzerinde yer alan TXD pini üzerinden lojik sinyali seri olarak 

vermekte, RXD pinine uygulanan seri sinyali ise ASCII kod yapısına göre karakter biçimine 
dönüştürmektedir. 

 
Şekil 4.5: VTerm 

 
4.1.5.1. ISIS Programında Virtual Terminal’in ( Vterm ) Kullanılması 

Ø İşlem Adımları 

• Virtual Instruments düğmesini kullanarak, kullanıcı kütüphanesinde 
isimleri listelenen VSM cihazları içinden Virtual Terminal üzerine 
tıklayınız. 

• Tasarım alanına Virtual Terminal’ı yerleştirmek istediğiniz yere farenin 
sol tuşuyla bir kere tıklayınız. Virtual Terminal’ı tasarım alanına 
yerleştirmiş oldunuz. 

• Şema üzerinde Virtual Terminal ile ilgili gerekli bağlantıları yapınız. 
• Play butonuna tıklayarak devrenizi çalıştırınız.  

 
4.1.6. COMPİM (Serial Port Model) 
 

Bir PC seri port ( UART) modelidir. PC seri portunun sahip olduğu bütün özelliklere 
sahiptir ve fiziksel olarak simüle edilebilir. Bu companenette baund hızı, data biti, parity biti, 
stop biti ve COM numarası vb. gibi özellikler ayarlanabilir. 
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Şekil 4.6: Compım 

 
4.1.7. Lojik Prob & Büyük Lojik Prob ( Logicprobe ) 

 
Bu eleman lojik devrelerde kullanılır. Bağlandığı noktanın lojik seviyesini gösterir. 

LGICPROBE ve LOGİCPROBE ( BIG ) olmak üzere iki çeşidi vardır. Aralarında yalnızca 
boyut farkı vardır. Kullanım ve işlev bakımından aralarında fark yoktur.  
 

 
Şekil 4.7: Tasarım alanına çağrılan lojik prob şekli 

 

 
Şekil 4.8: Simülasyon esnasında lojik prob şekli (lojik 1ve lojik 0 konumunda) 

 
4.1.8. Lojik State ( LOGİCSTATE )  

 
Bu eleman lojik devrelerde kullanılır ve bağlandıkları noktaya lojik sinyal uygular. 

Farenin sol tuşuyla üzerine tıklanırsa konum değiştirir ve tekrar tıklayana kadar aynı 
konumda kalır. 
 

             
Şekil 4.9: Lojik state’nin aldığı iki farklı konum 

 
4.1.9. Lojik Toogle ( LOGİCTOGGLE )  

 
LOGİCSTATE ile aynıdır. Tek farkı fare imleciyle üzerine sol tıklandığında lojik 1 

seviyesine gelir sol tuş bırakılınca lojik 0 seviyesine geri döner. 
 

                     
Şekil 4.10: LOGICTOGGLE’nin aldığı iki farklı konum 
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4.2. Tasarım Alanına Dijital Devre Elemanlarının Yerleştirilmesi 
 

4.2.1. Tasarım Alanına Dijital Elemanların Yerleştirilmesi 

Ø İşlem Adımları 

• ISIS elemanlar kütüphanesini açınız. 
• Libraries kısmından 74STD kütüphanesini bulunuz. Farenin sol tuşuyla 

bir kere tıklayınız. 74STD Kütüphanesi açılacaktır. 
• Açılan 74STD kütüphanesi içinden 7400, 7432 elemanlarını çağırınız. 
• Tekrar libraries kısmına dönünüz. Active kütüphanesinden, 

LOGIGSTATE ve LOGICPROBU (BIG) elemanlarını çağırınız. 
çağırınız. 

• Pick Devices penceresini kapatınız. 
• Devices bölümümden kütüphaneden çağırdığınız elemanları tasarım 

alanına Şekil 4.11’deki gibi yerleştiriniz. 
 

 
Şekil 4.11: Elemanların tasarım alanına yerleştirilmesi 

 
4.3. Bağlantı İletkenlerinin Çizilmesi 

 
4.3.1. Tasarım Alanında Bulunan Elemanlar Arasında Bağlantı İletkenlerinin 
Çizilmesi 

Ø İşlem Adımları 

• Şekil 4.11’deki elemanlar arasında bağlantı oluşturmak için  
(Component) düğmesini aktif hale getirin. 

• Fare imlecini bağlantı yapmak istediğiniz elemanın pini üzerine 
götürünüz. Göstergenin ucunda x işareti oluşunca bir kere sol tuşa 
tıklayınız ve bırakınız. 

• Bağlantı yapacağınız diğer elemanın pini üzerine gidiniz. Pin üzerinde x 
işareti oluşunca bir kere sol tıklayınız ve bırakınız. Böylece iki eleman 
arasında bağlantı oluşturmuş oldunuz. 

• Aynı yöntemi uygulayarak Şekil 4.12’deki gibi diğer elemanların 
bağlantılarını yapınız.  

• Play butonuna basınız ve devrenizi çalıştırınız. 
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• Farenin sol tuşunu kullanarak LOGIGSTATE elemanların konumlarını 
lojik 1 ve lojik 0 olarak değiştiriniz.  

• Her değişimden sonra devrenizin lojik çıkışını gözlemleyiniz. 
 

 
Şekil 4.12: Bağlantı iletkenlerinin çizilmesi 

 
4.3.2. Bağlantı Terminali Uygulaması 

Ø İşlem Adımları 

• Kütüphaneden AND, NOT, OR, 74HC86, LOGIGPROBE ve 
LOGICSTATE elemanlarını çağırınız. 

• Gadgets araç çubuğunda bulunan  (Inter-sheet) terminal araç 
düğmesine basınız ve malzeme kutusuna gelen terminal uçlarından 
DEFULT’u seçiniz. 

• Şekil 4.13’te verilen devreyi kurunuz ( terminal uçlarının devreye 
bağlantısı iki pinin birbirine bağlantısı gibidir.). 

•  (Instant edit mode ) düzenleme moduna geçiniz. Tasarım alanında en 
üstteki Logigstate üzerine sol tıklayınız. Açılan düzenleme penceresinden 
Component Reference yazısının yanındaki alana A yazınız. OK 
butonuna basarak yaptığınız işlemi onaylayınız. Böylece Logigstate’yi A 
olarak adlandırınız. Aynı yöntemle diğer lojik girişleri B ve C olarak 
adlandırınız. 

 

 
Şekil 4.13: Tam çıkarıcı devresi 
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• Lojik probun üzerine sol tıklayınız. Açılan düzenleme penceresinde 

Component Reference yazısının yanındaki alana BO, Component 
Value yazısının yanındaki alana ‘‘Borç Çıkışı’’ yazınız. OK butonuna 
basarak yaptığınız işlemi onaylayınız. Aynı yöntemle diğer probun 
sembolünü D, değerini fark olarak isimlendiriniz. 

• Düzenleme modundayken ismi A olan logicstate çıkışına bağlı bulunan 
giriş terminalinin üzerine farenin sol tuşuyla tıklayınız.  Açılan Edit 
Terminal Label penceresinde bulunan String kutusuna TA yazınız. 
konumunu Şekil 4.14’teki gibi düzenledikten sonra OK butonuna basarak 
pencereyi kapatınız. Böylece terminalinizi isimlendirmiş oldunuz. Aynı 
yöntemi kullanarak diğer terminalleri de isimlendiriniz. (Aralarında 
bağlantı olan terminallere aynı isimleri vermelisiniz.) 
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• Yine düzenleme modundayken TA isminin üzerine sol tıklayınız. Açılan 
Edit Terminal Label penceresi üzerinde bulunan Style butonuna sol 
tıklayınız. Açılan pencereden Fallow Global? seçeneğinin onayını 
kaldırınız. Height kutusu aktif hale gelecektir. Bu kutudan yazının 
yüksekliğini 0.2in olarak ayarlayınız.  OK butonuna basarak işleminizi 
onaylayınız ( Şekil 4.15). Tasarım alanına baktığınızda TA yazısının 
boyutunun büyümüş olduğunu göreceksiniz. Aynı pencereyi kullanarak 
yazının rengini, yazı tipini, kalınlığını, vb. özelliklerini değiştirebilirsiniz.  

 

 
Şekil 4.14: Terminal uçlarının isimlendirilmesi 

 
• Aynı yöntemi kullanarak diğer terminallerin de isimlerinin boyutlarını 

büyütünüz. 
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Şekil 4.15: Terminal isimlerinin stil ayarlarının yapılması 

 
• Devrenizi çalıştırınız.  
• Devrenin girişlerine Tablo 4.1’de verilen lojik durumları sırasıyla 

uygulayınız. Devrenin lojik çıkışlarını gözlemleyiniz. 
 

C A B D BO 
0 0 0 0 0 
0 0 1 1 1 
0 1 0 1 0 
0 1 1 0 0 
1 0 0 1 1 
1 0 1 0 1 
1 1 0 0 0 
1 1 1 1 1 

Tablo 4.1: Tam çıkarıcının doğruluk tablosu 
 

• Bağlantı terminalleri kopmlex devrelerde elemanlar arası bağlantıyı 
oluşturmak için kullanılır. Devrenin daha sade görünmesini sağlar.  

 
4.3.3. Çoklu Yol ( Bus ) Uygulaması 

Ø İşlem Adımları 

• AND, OR, NOT, 74136, LOGIGPROBE (BIG) ve LOGICSTATE 
elemanlarını tasarım alanına çağırınız. 

• Şekil 4.16’da gösterildiği gibi elemanları tasarım alanına yerleştiriniz. 
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Şekil 4.16: Elemanların tasarım alanına yerleştirilmesi 

 
• Main Modes araç çubuğunda bulunan   (Bus) butonunu aktif hale 

getiriniz. 
• Şekil 4.17’de gösterildiği gibi tasarım alanında çoklu yol oluşturunuz. 
• Çoklu yol ile bağlantısı yapılacak bütün pinleri Şekil 4.17’de görüldüğü 

gibi yapınız. (Elemanların çoklu yol ile bağlantısının yapılması iki pinin 
birbirine bağlantısı gibidir.) 

• Main Modes araç çubuğu üzerinde bulunan  düğmesini aktif hale 
getiriniz. Fare imlecini pin ile çoklu yol arasında kalan hattın üzerine 
götürünüz. Fare imleci ucunda x şekli oluşunca sol tıklayınız. Karşınıza 
gelen Edit Wire Label penceresinden String yazısının yanındaki kutu 
içerisine hattın ismini yazınız ve OK butonuna basarak işleminizi 
onaylayınız. 

• Hatta verdiğiniz ismin yüksekliğini 0.2in olarak değiştiriniz ( Uygulama 
23’e bakınız.). 

• Aynı yöntemi kullanarak bütün hatları isimlendiriniz (Aralarında bağlantı 
olan hatlara aynı isimleri vermelisiniz.). 

 

 
Şekil 4.17: Çoklu yol kullanılarak yapılmış lojik diyagram 

 
• Devrenizi çalıştırınız. 
• Devrenizin girişlerinde kullanılan lojik sinyallerin konumlarını 

değiştirerek devrenizin çıkış konumunu gözlemleyiniz. 
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4.4. Dijital Devreye Test Aygıtlarının Bağlanması 
 
4.4.1. Lojik Analizörden D Tipi Flip_Flop’un Çıkış Sinyallerinin İncelenmesi 

Ø İşlem Adımları 

• Şekil 4.18’deki devreyi kurunuz. 
• D/FF’un D girişine uygulanan bilgi sinyalini tasarım alanına çağırmak 

için Gadgets araç çubuğunda bulunan  (Generatör) düğmesine 
tıklayınız ve açılan sinyal çeşitlerinden DCLOCK sinyalini seçiniz. 

 
Şekil 4.18: D tipi flip- flop  

 
• DCLOCK sinyalini Şekil 4.19’daki gibi düzenleyiniz.  

 

 
Şekil 4.19: DCLOCK sinyali düzenleme penceresi 
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• Clock üretecinin frekansını 1KHz olarak ayarlayınız. 
• Devrenizi çalıştırınız. 
• Şekil 4.20’de verilen VSM Lojik Analyser ekran görüntüsü karşınıza 

gelecektir.  
• Lojik analizör ekranı devreyi ilk çalıştırdığınızda boştur. Trigger 

butonuna basarak sinyalleri göstermesini sağlayınız. 
• Sinyalin görüntü olarak genişliğini ayarlamak için Zoom düğmesini sağa-

sola çeviriniz. 
• Sinyalin zaman aralığını ayarlamak için Resolution düğmesini sağa-sola 

çeviriniz (Bu işlemden sonra  tekrar  Trigger düğmesine basmalısınız.). 
 

 

 
Şekil 4.20: VSM logic analyser ekran görüntüsü 

 
4.4.2. Frekansmetre Uygulaması 

Ø İşlem Adımları 

• Kütüphaneden Clock elemanını çağırınız. 
•    ( Virtual Instruments)   düğmesini kullanarak COUNTER TIMER 

elemanını tasarım alanına çağırınız. 
• Şekil 4.21’deki devreyi kurunuz. 

 

 
Şekil 4.21: Frekansmetre uygulama devresi 

 
• Clock üretecinin frekansını 100Hz olarak ayarlayınız. 
• Frekansmetreyi Şekil 4.22’deki gibi ayarlayınız. 
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Şekil 4.22: Frekansmetrenin düzenleme penceresi 

 
• Devrenizi çalıştırınız. 
• Frekansmetrenin ekranından clock üretecinin frekansı görülecektir. 

 
4.4.3. Yarım Toplayıcı Devresinin Yapımı 

Ø İşlem Adımları 

• Kütüphaneden AND, 74136 ve LED-RED elemanlarını çağırınız. 
• Gadgets araç çubuğunda bulunan  (Generator) düğmesini tıklayınız. 

Açılan sinyal çeşitlerinden DPATTERN sinyal çeşidini seçiniz. 
• Şekil 4.23’teki devreyi kurunuz. 

 

 
Şekil 4.23: EXOR ve and kapılı yarım toplayıcı devresi 

 
• Düzenleme modundayken DPATTERN sinyallerini Şekil 4.24’deki gibi 

ayarlayınız. 
• Yine düzenleme modundayken terminal uçlarını isimlendiriniz. 

(Uygulama 23’e bakınız.)  
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Şekil 4.24: DPATTERN sinyallerinin düzenlenmesi 

 
• Devrenizi çalıştırınız. Çıkış ledlerini gözlemleyiniz. 
• DPATTERN elemanları dijital devrelerin girişlerine lojik sinyaller 

vermek için kullanılır. DPATTERN sinyalinin düzenleme penceresinde 
Pulse width ( Secs ) seçeneği ile devreye verilecek 1 bitlik lojik sinyalin 
(palsin) genişliği saniye olarak ayarlanır. Specific pulse train seçeneği ile 
de devreye verilecek lojik sinyallerin (palslerin) sırasını kullanıcı kendisi 
belirleyebilir.  

 
4.4.4. NE 555 Entegresi ile Yapılan Tek Kararlı Multivibratör Devresi 

Ø İşlem Adımları 

• Şekil 4.25’teki devreyi kurunuz. 
• Clock sinyalinin frekansını 50Hz olarak ayarlayınız. 
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Şekil 4.25: NE 555 entegresi ile yapılan tek kararlı multivibratör devresi 

 
• Clock sinyalini ve multivibratörün çıkış sinyalini Osilaskopta 

gözlemleyiniz (Üstteki sinyal multivibratörün çıkış sinyalini, alttaki 
sinyal Clock palsini göstermektedir.). 

 

 
Şekil 4.26: Osilaskop ekranı 

 
• 5KΩ direnç 5µF’lık kondansatör zamanlama elemanlarıdır. 555’li 

multivibratör devrelerinde bu direncin değeri 1MΩ ve kondansatörün 
değeri 100µF gibi büyük değerde seçilir. Biz multivibratörün konum 
değişimini osilaskoptan daha iyi gözlemleyebilmek için düşük değerli 
direnç ve düşük kapasiteli kondansatör seçtik. 

• Siz de zamanlama elemanlarının değerlerini değiştirerek multivibratörün 
çıkışını gözlemleyiniz. 

• Tek karalı multivibratörler, girişlerine tetikleme sinyali uygulandığında 
konup değiştirip zamanlama elemanlarının belirledikleri sürece bu 
konumda kalan, süre sonunda tekrar ilk konumuna dönen devrelerdir. 
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4.4.5. PIC 16F877 ile Seri LCD Displayin Kontrolünün Yapılması 

Ø İşlem Adımları 

• File→Load Design seçeneklerini çalıştırınız. SAMPLES\ Milford Serial 
LCD Demo\ RS232LCD dosyasını tasarım alanına çağırınız.  

• Şekil 4.27’deki devre tasarım alanında görülecektir. 
 

 
Şekil 4.27: PIC ile LCD kontrolü 

 
• Play butonuna basarak devreyi çalıştırınız. 
• VTerm Cihazının simülasyon penceresi karşınıza gelecektir (Şekil 4.28). 

 

 
Şekil 4.28: VTerm ekranı 

 
• LCD’nin ekranında gösterilen “Milford LCD Demo” yazısı çıkıp, kursör 

2. satıra indikten sonra yanıp sönmeye başladıktan sonra Virtual terminal 
penceresi kullanılarak klavyeden yazılan yazılar LCD ekranında 
görünecektir. 

• Bu devrede VTerm cihazı, PIC’e seri veri göndermektedir. PIC’de bu seri 
verilerin kodunu çözerek LCD ekranında göstermektedir. 
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ÖLÇME VE DEĞERLENDİRME 

 
Bu bölümde 4 nu’lu öğrenme faaliyetinde anlatılan konular hakkında bilginizi ve 

yeteneğinizi ölçmek amacıyla çoktan seçmeli sorular sorulacaktır. Soruları duyarlılıkla 
yanıtlamanız önerilir. 

 
ÖLÇME SORULARI 

1. Aşağıdaki cihazlardan hangisi dijital sinyallerin durumunu diyagram şeklinde gösterir?  
A) Pattern Jeneratörü  
B) Lojik Analizör  
C) Virtual Terminal 
D) COMPIM 

2. Aşağıdaki cihazlardan hangisi seri iletişim ara birimi olarak kullanılır?  

A) Pattern Jeneratörü  
B) Lojik Analizör  
C) Virtual Terminal 
D) COMPIM 

 
3. Aşağıdaki seçeneklerden hangisi COMPIM cihazının özelliklerinden değildir? 

 
A) PC seri port modelidir.  
B) Baund hızı, data biti, parity biti, stop biti ve COM numarası gibi özellikler 
ayarlanabilir. 
C) Fiziksel olarak simüle edilebilir. 
D) Girişine bağlanan hattaki lojik sinyalin değişim sayısını ölçer. 
 

4. Aşağıdaki seçeneklerden hangisi Logicstatenin özelliklerinden değildir? 
 

A) Logicstate ve Logicstate ( Big) olmak üzere iki çeşidi vardır. 
B) Bağlandığı noktaya lojik sinyal uygular. 
C) Farenin sol tuşuyla üzerine tıklandığında konum değiştirirler. 
D) Lojik 1 konumunda mavi, Lojik 0 konumunda kırmızı rengi alırlar. 

5. Ana Modlar araç çubuğunda yer alan yandaki simgenin ( ) işlevi nedir? 

A) Devreye terminal eklemek için kullanılır. 
B) Devreye pin eklemek için kullanılır. 
C) Birleşme noktası eklemek için kullanılır. 
D) İletken bağlantısını etiketlemek, isimlendirmek için kullanılır. 

 

ÖLÇME VE DEĞERLENDİRME 
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6. TERMİNALS malzeme kutusunda aşağıdaki elemanlardan hangisi yer almaz? 
 

A) INVERT 
B) OUTPUT 
C) BIDIR 
D) INPUT 

 
7. Tasarım alanında çoklu yol oluşturmak için aşağıdaki butonlardan hangisi kullanılır? 

 
A)                   B)               C)                   D)   

8. Aşağıdaki seçeneklerden hangisi DPATTERN sinyalinin özelliklerinden değildir? 

A) Devrenin girişlerine lojik sinyaller vermek için kullanılır. 
B) Devreye verilecek bir bitlik lojik sinyalin genişliği dakika olarak ayarlanır. 
C) Devreye verilecek lojik sinyallerin sırasını kullanıcı kendisi belirler. 
D) GENERATORS malzeme kutusunun içinde yer alır. 

 
 
 
 
 

DEĞERLENDİRME 
 

Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek 
kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt ettiğiniz 
sorularla ilgili konuları faaliyete dönerek tekrar inceleyiniz. 

 
Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz. 
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ÖĞRENME FAALİYETİ-5 
 
 
 
Uygun ortam sağlandığında basit kapı devrelerinin tasarımını yaparak çalışmalarına 

ait sonuçları değerlendirebileceksiniz. ISIS programında çeşitli devre tasarımları yaparak 
çalışmalarına ait sonuçları değerlendirebileceksiniz. 

 
 
 
Bu faaliyet öncesinde yapmanız gereken öncelikli araştırmalar şunlardır: 

Ø Dijital elektronik kitaplarınızdan lojik kapılarla tasarlanmış devrelerin çalışma 
prensiplerini inceleyiniz.  

Ø TTL ve CMOS entegreleri hakkında bilgi edininiz. 

 

5. DİJİTAL DEVRE UYGULAMALARI 
 
5.1. Basit Kapı Devreleri Tasarımı ve Analizinin Yapılarak 
Sonuçların Değerlendirilmesi 
 
5.1.1. VE Kapısı Deneyi 
 

Ø İşlem Adımları 
 

• Şekil 5.1’de verilen devreyi kurunuz. 
• Bataryanın değerini 5V olarak ayarlayınız.  
• SW1 anahtarını A ve SW2 anahtarını B olarak adlandırınız. 

 

 
Şekil 5.1: VE kapısı deneyi 

ÖĞRENME FAALİYETİ–5 

AMAÇ 

ARAŞTIRMA 
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• A ve B anahtarlarının konumlarını GND ( lojik 0 ) konumlarına getiriniz 
( LED’i gözlemleyiniz. LED yanıyorsa lojik 1 yanmıyorsa lojik 0 olarak 
değerlendirilir.). 

• A ve B anahtarlarının konumlarını 5V ( lojik 1 ) konumlarına getiriniz. 
LED’i gözlemleyiniz.  

• A anahtarını lojik 1, B anahtarını lojik 0 konumuna getiriniz. LED’i 
gözlemleyiniz. 

• A anahtarını lojik 0, B anahtarını lojik 1 konumuna getiriniz. LED’i 
gözlemleyiniz. 

• Anahtarların pozisyonlarına göre VE kapısının doğruluk tablosu Tablo 
5.1’deki gibi olacaktır. 

 
A B ÇIKIŞ 
0 0 0 
1 1 1 
1 0 0 
0 1 0 

Tablo 5.1: Ve kapısının doğruluk tablosu 
 

• VE kapısının her iki girişi lojik 1 seviyesinde ise çıkış lojik 1 
seviyesindedir. Girişlerden biri veya ikisi lojik 0 seviyesinde ise çıkış 
lojik 0 seviyesindedir. 

• Aynı deneyi diğer kapılarla da yapınız ve sonucu gözlemleyiniz. 
 

5.1.2. DEĞİL ve VEDEĞİL Kapıları ile ÖZEL VEYA Kapısının Elde Edilmesi 
 
Ø İşlem Adımları 

 
• Şekil 5.2’de verilen devreyi kurunuz. 
• Devrenin girişlerinde anahtar yerine logicstate elemanları kullanılmıştır. 

Böylece devre hem daha sade hem de daha anlaşılır olmaktadır. 
• Logicstate elemanları sırasıyla A ve B olarak adlandırınız. 

 

 
Şekil 5.2: Değil-ve-vedeğil kapıları ile özel veya kapısının elde edilmesi 
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• A ve B girişlerinin konumlarını değiştirerek LED’in durumunu 
gözlemleyiniz. 

• A ve B girişlerinin konumlarına göre ÖZEL VEYA kapısının doğruluk 
tablosu Tablo 5.2’deki gibi olacaktır. 

 
A B ÇIKIŞ 
0 0 0 
1 1 0 
1 0 1 
0 1 1 

Tablo 5.2: Özel veya kapısının doğruluk tablosu 
 

• ÖZEL VEYA kapısının girişlerinin durumu birbirlerinden farklı ise ( biri 
lojik 1 diğeri lojik 0) çıkış lojik 1’dir. Giriş değişkenlerinin durumları 
aynı ise çıkış lojik 0’dır. 

 
5.1.3. Lojik Kapılarla 2 Bitlik Karşılaştırıcının Yapılması 
 

Ø İşlem Adımları 
 

• Şekil 5.3’te verilen devreyi çiziniz. 
• Devrenin daha sade görünmesi için çıkışlarında  LED yerine lojik prob 

kullandık ( İsteğinize bağlı olarak LED de kullanabilirsiniz.). 

 
Şekil 5.3: 2 bitlik karşılaştırıcı devresi 

 
• Lojik girişleri sırasıyla A ve B olarak adlandırınız. 
• Lojik çıkışları sırasıyla A>B, A=B, A<B olarak adlandırınız. 
• A ve B girişlerinin konumlarını değiştirerek devrenin lojik çıkışlarını 

inceleyiniz. 
• A ve B girişlerinin konumlarına göre karşılaştırıcı devresinin doğruluk 

tablosu Tablo 5.3’deki gibi olacaktır. 
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A B A>B A=B A<B 
0 0 0 1 0 
1 1 0 1 0 
1 0 1 0 0 
0 1 0 0 1 

Tablo 5.3: 2 bitlik karşılaştırıcı devresinin doğruluk tablosu 
 

5.1.4. AND/NAND Kapılı Tetiklemeli RS Flip-Flop’un Oluşturulması ve 
İncelenmesi 

 
Ø İşlem Adımları 

 
• Şekil 5.4’te verilen devreyi tasarlayınız. 
• Devrenin R ve S girişlerine bağlanan sinyalleri tasarım alanına çağırmak 

için Gadgets araç çubuğunda bulunan  (generatör) düğmesine 
tıklayınız ve açılan sinyal çeşitlerinden DPATTERN sinyalini seçiniz. 

 

 
Şekil 5.4: AND/NAND kapılı tetiklemeli rs flip-flop 

 
•  (Instant edit mode) butonu aktif iken DPATTERN sinyallerini Şekil 

5.5’teki gibi düzenleyiniz. 
• Devrenin girişine uygulanan clock palsinizi tasarım alanına çağırmak 

yine için Gadgets araç çubuğunda bulunan  (generator) düğmesine 
tıklayınız ve açılan sinyal çeşitlerinden DCLOCK sinyalini seçiniz. 

• Düzenleme modundayken Clock Palsinizi Şekil 5.6’daki gibi 
düzenleyiniz. 

• Düzenleme modundayken AND ve NOR kapılarını Şekil 5.7’deki gibi 
düzenleyiniz 

 
Data To Q Delay ( Low-High ) : 100n 
Data To Q Delay (High -Low) : 100n 
Deglitch Time For Q Output   : 50n 
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Şekil 5.5: DPATTERN düzenleme penceresi  Şekil 5.6: CLOCK Sinyali düzenleme 

penceresi 
 

• Devrenizi çalıştırınız. 
• Devrenizin lojik sinyallerini görmek için lojik diyagramını çizelim. 
• Gadgets araç çubuğunda bulunan   (Simulation Graph) düğmesine 

tıklayınız. Gösterilen grafik çeşitlerinden DIGITAL grafik çeşidini 
seçiniz ve tasarım alanında grafik alanınızı belirleyiniz (Faaliyet 3 / 
Uygulama 15’e bakınız.). 

 

 
Şekil 5.7: NAND ve NOR kapısı düzenleme penceresi 

 
• Graph→Edit Graph seçeneklerini çalıştırınız ve Şekil 5.8’deki 

düzenlemeleri yapınız. 
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• Düzenlemeyi yaptıktan sonra grafiğin bu değişikliklere göre 
simülasyonunun tekrar yapılıp yapılmayacağı sorulur. YES butonuna 
tıklayarak evet cevabını veriniz. 

 

 
Şekil 5.8: Grafik düzenleme penceresi 

 
• Graph→Add Trace seçeneklerini çalıştırınız. Karşınıza gelen pencerede 

Şekil 5.9’daki düzenlemeleri yapınız ( Her sinyal için aynı işlemi 
tekrarlayınız.). 

• Giriş ve çıkış işlemlerinin seçim işlemi bittikten sonra Graph→Simulate 
Graph seçeneklerini çalıştırınız. 

 

 
Şekil 5.9: R girişinin grafikte gösterilmesi 

 
• RS Flip-Flop’un lojik diyagramı Şekil 5.10’daki gibi olacaktır. 
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Şekil 5.10: RS Flip-flop’un lojik diyagramı 

 
5.2. Çeşitli Devre Tasarımları ve Analizlerinin Yapılarak Sonuçların 
Değerlendirilmesi 

 
5.2.1. D Tipi FF’lu Asenkron Yukarı Sayıcı Devresi 

 
Ø İşlem Adımları 

 
• Kütüphaneden 74EG-BCD, DTFF ve CLOCK elemanlarını çağırınız. 
• Şekil 5.11’de verilen devreyi tasarım alanına kurunuz. 
• CLOCK üretecini 1Hz olarak ayarlayınız. 
• Devrenizi çalıştırınız. 
• Clock üretecinin frekansını istediğiniz değişik frekanslarda ayarlayarak 

devrenizin çalışmasını inceleyiniz. 
 

 
Şekil 5.11: D/FF’lu asenkron yukarı sayıcı devresi 

 
5.2.2. Subcircuit Uygulaması (Entegre Devrenin Oluşturulması) 
 

Ø İşlem Adımları 
 

• Boş bir tasarım alanı açınız. 
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• Main Modes araç çubuğunda bulunan  ( Subcircuit) düğmesine 
tıklayınız. 

• Fare imlecini tasarım alanında subcircuit oluşturmak istediğiniz yere 
götürünüz. 

• Sol tuşa basılı tutunuz ve fare imlecini sürükleyerek bir kare oluşturunuz 
( Şekil 5.12 ). 

 
Şekil 5.12: Subcircuit oluşturulması 

 
• Subcircuit kutusu oluşturulduktan UNNAMED CHİLD SHEET isimli bir 

tasarım alanı daha oluşur. Bu tasarım alanı ana tasarım alanına bağlı olan 
bir alt tasarım alanıdır ve bu tasarım alanında subcircuit kutusunun içinde 
bulunacak olan devre oluşturulur. Bu tasarım alanının içi boştur. Bu 
tasarım alanını incelemek için Design- Goto Sheet seçeneklerini 
çalıştırınız. Karşınıza Şekil 5.13’teki gibi bir pencere gelecektir. Fare 
imlecini UNNAMED CHİLD SHEET üzerine götürünüz ve OK 
butonuna basınız. Böylece UNNAMED CHİLD SHEET tasarım alanı 
açılacaktır. 

• Ana tasarım alanına geri dönmek için Design→Exit to Parent 
seçeneklerini çalıştırınız. 

 

 
Şekil 5.13: Alt tasarım alanının görünümü 

 
• Ana tasarım alanında bulunan Subcircuit’ isim vermek için düzenleme 

modundayken fare imleciyle Subcircuit’in üzerine geliniz ve sol 
tıklayınız. Şekil 5.14’te verilen Edit Subcircuit penceresi açılacaktır. 
Name kutusuna EX-OR, Circuit kutusuna ÖZEL VEYA yazınız. Ok 
butonuna basınız. Böylece Subcircuit’ı isimlendirmiş oldunuz. 
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Şekil 5.14: Subcircuit düzenleme penceresi 

 
• 8. Subcircuit’ın ismini EX-OR devrenin ismini ÖZEL VEYA olarak 

adlandırmış oldunuz. 

 
Şekil 5.15: Subcircuit’a isim verilmesi 

 
• Alt tasarım alanının adı da EX-OR olarak değişir. Alt tasarım alanına 

geçmek için Design→ Goto Sheet seçeneklerini çalıştırınız. Karşınıza 
gelen pencereden fare imleciyle EX-OR alt tasarım alanına geliniz ve OK 
butonuna basınız. 

 

 
Şekil 5.16: Alt tasarım alanına geçilmesi 

 
• Açılan alt tasarım alanı boş olacaktır. Bu tasarım alanı üzerine . 

Subcircuit olarak oluşturmak istediğiniz devre çizilir. 
• Şekil 5.17’deki devreyi çiziniz. 
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Şekil 5.17: Subcircuit devresinin oluşturulmaya başlanması  

 
• Gadgets araç çubuğu üzerinde bulunana  (Inter-sheet Terminal) araç 

düğmesine basınız ve malzeme kutusuna gelen terminal uçlarından 
INPUT terminalini seçiniz. 

• Tasarım alanında bulunan devrenizin giriş uçlarına sol tıklayınız. 
Terminaller devrenizin giriş uçlarına eklenecektir.  

• Malzeme kutusundan OUTPUT terminalini seçiniz. Devrenizin çıkışına 
bu terminali ekleyiniz. 

• Şekil 5.18’deki gibi bu terminalleri devrenize bağlayınız. 
 

 
Şekil 5.18: Terminal uçlarının devreye bağlanması 

 
• Düzenleme modundayken devrenizin giriş ve çıkış uçlarını isimlendiriniz 

(Şekil 5.19). 
 

 
Şekil 5.19: Terminal uçlarının isimlendirilmesi 
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• Yine düzenleme modundayken Q1 terminalinin üzerine sol tıklayınız. 
Açılan Edit Terminal Label penceresinden Style butonuna basınız. Fallow 
Global seçeneğindeki onayı kaldırınız. Height kutusu aktif hale 
gelecektir. Buradan terminal isminin boyutunu 0.2in olarak ayarlayınız. 
Terminal isminin diğer özelliklerini de istediğiniz gibi ayarlayabilirsiniz. 

• Aynı yöntemi kullanarak diğer terminal uçlarının isimlerinin boyutlarını 
0.2in olarak ayarlayınız. 

 

 
Şekil 5.20: Subcircuit oluşturacağımız devrenin tamamlanmış hali 

 
• Böylece Subcircuit oluşturacağınız devreyi tamamlamış oldunuz (Şekil 

5.20). 
• Şimdi ana tasarım alanına dönünüz. 
• Main Modes araç çubuğunda bulunan   (Subcircuit )  araç düğmesine 

basınız. Açılan portlardan INPUT portunu seçiniz. Fare imlecini tasarım 
alanında bulunan Subcircuit’ın sol üste yakın kenarına götürünüz ve bir 
kere sol tıklayınız. Giriş terminali Subcircuit’a bağlanmış olacaktır. Şekil 
5.21’deki gibi giriş terminallerini yerleştiriniz. 

• Bu defa OUTPUT portunu seçiniz ve Şekil 5.21’de görüldüğü gibi 
Subcircuit’ın çıkışına yerleştiriniz. 

 
Şekil 5.21: Subcircuit portlarının bağlanması 

 
• Düzenleme moduna geçiniz ve portları isimlendiriniz. Portlara 

vereceğiniz isimler alt tasarım alanında oluşturduğunuz devrenin giriş ve 
çıkış terminallerine vereceğiniz isimlerle aynı olmalıdır. 



 

 94 

 
Şekil 5.22: Subcircuit portlarının isimlendirilmesi 

 
• Subcircuit devrenizi oluşturmuş oldunuz. ( Şekil 5.22 ) 
• Şekil 5.23’teki devreyi kurunuz. 
• Devrenizi çalıştırınız. Devrenizin çalışması alt tasarım alanında 

oluşturduğunuz devrenin çalışmasıyla aynı olmalıdır (ÖZEL VEYA 
olarak çalışmalıdır.). 

 
Şekil 5.23: Subcircuit ile oluşturulan devrenin çalıştırılması 

 
5.2.3. PIC İle Step Motor Kontrolünün Yapılması 
 

Ø İşlem Adımları 
 

• File→Load Design seçeneklerini çalıştırınız.  
• Samples/Motor Examples /PICSTEPR dosyasını tasarım alanına 

çağırınız. 
• Şekil 5.24’te verilen devre tasarım alanında görülecektir. 
• Play butonuna basarak devrenizi çalıştırınız. 
• Devredeki butonlara sırasıyla basarak step motoru ileri-geri hareket 

ettiriniz. 
• Düzenleme modundayken fare imlecini PIC16F84A entegresinin üzerine 

getiriniz ve sol tıklayınız. Açılan edit penceresinden pic’in özelliklerini 
inceleyiniz. 



 

 95 

 
Şekil 5.24: PIC ile step motor uygulaması 

 
5.2.4. Eleman Oluşturulması ve Kütüphaneye Eklenmesi 

 
DS1868 çiftli dijital potansiyometre entegresi oluşturacağız.  
Bu entegrenin özellikleri: 

Ø Ultra düşük güç tüketimi 
Ø İki dijital kontrollü 256 durumlu potansiyometre 
Ø İki potansiyometre için Seri portla tanımlanan okuma ve set etme  
Ø Yüksek dirençler elde edebilmek için dirençlerin seri bağlanabilmesi 
Ø +5 yada +3 volt operasyon 
Ø Standart direnç değerleri 

• DS1868-10 10K 
• DS1868-50 50K 
• DS1868-100 100K 

 
Ø İşlem Adımları 

 
• Yeni bir çalışma sayfası açınız. 
• 2D araç çubuğu üzerinde bulunan  ( 2D Graphics Box) araç 

düğmesine sol tıklayınız.  
• Açılan Graphic Styles seçeneklerinden COMPONENT’i seçiniz. 
• Tasarım alanında sol tuşa basılı tutarak istediğiniz boyutta bir dikdörtgen 

çiziniz. Böylece elemanınızın dış çerçevesini belirlemiş oldunuz. 
• Oluşturduğunuz dikdörtgeni farenin sağ tuşunu kullanarak blok içerisine 

alınız. ( Şekil 5.25 ) 
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Şekil 5.25: Eleman şeklinin oluşturulması 

 
• Eleman şeklinizi oluşturduktan sonra Library→Make Symbol 

seçeneklerini çalıştırınız. 
• Açılan Make Symbol penceresini Şekil 5.26’daki gibi düzenleyiniz. 

 

 
Şekil 5.26: Make symbol penceresi 

 
• Gadgets araç çubuğu üzerinde bulunan (device pin) düğmesine basınız ve 

açılan pin çeşitleri içinden DEFAULT pinini seçiniz. 
• Yeni oluşturduğunuz elemanın,  pinlerini oluşturacağınız yerlerine fare 

imlecini götürünüz ve bir kere sol tıklayınız. 
• Şekil 5.27’de görüldüğü gibi elemanın pinlerini yerleştiriniz. 

 

 
Şekil 5.27: Elemanın pinlerinin oluşturulması 

 
• Elemanın pinlerine numara ve isim vermek için düzenleme moduna 

geçiniz. Fare imlecini elemanın sol en üst pini üzerine götürünüz ve sol 
tıklayınız. Açılan Edit Pin penceresini Şekil 5.28’deki gibi düzenleyiniz. 
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Şekil 5.28: Edit pin penceresi 

 
• 1 nu’lu pine isim ve numara verdikten sonra aynı yöntemle diğer pinlere 

de isim ve numara veriniz. 
 

 
Şekil 5.29: Pinlerin isim ve numaralandırma işleminin bitirilmesi 

 
• Şimdi elemanı blok içerisine alınız. Library→Make Device 

seçeneklerini çalıştırınız. 
• Karşınıza gelen Make Device penceresinden elemanınıza isim ve sembol 

ismi veriniz. Next butonuna basınız (Şekil 5.30). 
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Şekil 5.30: Make device penceresi 

 
• Karşınıza Şekil 5.31’deki pencere gelir. Bu pencerede Add/Edit 

butonuna basınız. 
 

 
Şekil 5.31: Elemanın PCB tanımlama penceresi 

 
• Karşınıza Şekil 5.32’deki pencere gelecektir. Bu pencere aracılığı ile 

elemanınıza PCB tanımlamaları yapabilirsiniz ve pinlerde istediğiniz 
değişiklikleri yapabilirsiniz. İstediğiniz değişiklikleri yaptıktan sonra 
Add butonuna basınız. 
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Şekil 5.32: Package device penceresi 

 
• Karşınıza Şekil 5.33’de verilen pencere gelir. Bu pencere aracılığı ile 

yaptığınız elemanda baskılı devre çiziminde kullanılmak üzere uygun 
olan PCB pin bağlantısını seçiniz ve farenin sol tuşu ile üzerine çift 
tıklayınız. 

 

 
Şekil 5.33: Pick packages penceresi 
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• Package device penceresi açılacaktır. Pencerenin sol tarafında elemanın 
pinleri ve özellikleri görülmektedir. Pin isimlerinin üzerine sol tıklayarak 
seçili hale getirebilir ve seçili durumdayken sağ tıklayarak özelliklerini 
değiştirebilirsiniz (Şekil 5.34). 

 

 
Şekil 5.34: Package device penceresi 

 
• Package Device penceresindeyken Assign Package(s) butonuna basınız. 

Şekil 5.35’deki pencere ekrana gelecektir. Bu pencerede elemanınız için 
tanımladığınız PCB pin bağlantısının görünüşü yer alır. Next butonuna 
basınız. 
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Şekil 5.35: Make device penceresi 

 
• Ekrana Şekil 5.36’daki pencere gelecektir. Bu pencerede elemanla ilgili 

tanımlamalar bulunur. Başka tanımlamalar yapmak istiyorsanız New 
butonuna basınız. Tanımlamalar bittikten sonra Next butonuna basınız. 

 

 
Şekil 5.36: Elemana özellik ekleme penceresi 
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• Şekil 5.37’de verilen pencerede eleman için varsa Data sheet dosyası 
tanımlanır. Eğer eleman için yardım dosyası oluşturduysanız bu pencere 
aracılığı ile bu yardım dosyası da tanımlanır. Tanımlama işlemini 
bitirdikten sonra Next butonuna basınız. 

 

 
Şekil 5.37: Elemana data sheet ekleme penceresi 

 
• Ekrana gelen pencerede elemanın ekleneceği kütüphane seçilir. Bu 

pencerede sadece USERDVC kütüphanesi görülür. OK butonuna basarak 
elemanı bu kütüphaneye ekleyiniz. 

• DS 1868 elemanı USERDVC kütüphanesine yerleşmiş oldu. 
• Oluşturduğunuz elemanı tasarım alanına çağırınız (Şekil 5.38). 
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Şekil 5.38: Oluşturduğunuz elemanın tasarım alanındaki görüntüsü 

 
5.2.5. Tasarım Alanında Bulunan Devrenin Malzeme Listesinin Çıkarılması 

 
Ø İşlem Adımları 

 
• File→Load Design komutlarını çalıştırınız. Açılan pencereden 

SAMPLES-Animated Circuits klasörünün içinde bulunan Opamp01 
dosyasını tasarım alanına çağırınız. 

• Tools→Bill of Materials-Defult seçeneklerini çalıştırınız. 
• Devrenin malzeme listesi rapor halinde sunulacaktır (Şekil 5.39). 
• Pencerenin altında bulunan Clipboard butonunu kullanarak malzeme 

listenizi Windows işletim sisteminin panosuna alabilirsiniz. 
• Yine pencerenin altında bulunan Save As butonunu kullanarak malzeme 

listesini bir rapor halinde kaydedebilirsiniz. 
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Şekil 5.39: Tasarım alanında bulunan devrenin malzeme listesi 

 
5.2.6. Tasarım Alanında Bulunan Devrede Elektriksel Hatanın Test Edilmesi 
 

Ø İşlem Adımları 
 

• Şekil 5.40’daki devreyi tasarım alanına kurunuz. 
 

 
Şekil 5.40: Opampın toplar yükselteç olarak kullanılması 

 
• Devrenizi çalıştırınız. 
• Tools→Electrical Rules Check seçeneklerini çalıştırınız. Açılan 

Electrical Rules Check penceresini inceleyiniz. 
• En son satırda verilen “No ERC errors found” mesajı devrenizde 

elektriksel hata olmadığını bildirmektedir (Şekil 5.41). 
• Komplex devrelerde elektriksel hata testinin yapılması devrenin doğru 

çalışabilmesi bakımından önemlidir. 
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Şekil 5.41: Elektriksel hata testi  
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ÖLÇME VE DEĞERLENDİRME 
 
 

Bu bölümde 5 nu’lu öğrenme faaliyetinde anlatılan konular hakkında bilginizi ve 
yeteneğinizi ölçmek amacıyla çoktan seçmeli sorular sorulacaktır. Soruları duyarlılıkla 
yanıtlamanız önerilir. 
 
ÖLÇME SORULARI 

1. İstenen tasarım alanına geçmek için aşağıdaki işlemlerden hangisi yapılır?  

A) Design → New Sheet 
B) File → Load Design  
C) Design → Goto Sheet  
D) File → New Design 

 
2. Aşağıdaki butonlardan hangisi entegre devre oluşturmak için kullanılır? 

A)        B)                         C)     D)  
 

3. Library→ Make Device seçenekleri ile aşağıdaki işlemlerden hangisi yapılır? 
 

A) Kütüphaneye eklemek için oluşturulan yeni elemana sembol ismi vermek için 
kullanılır. 
B) Kütüphaneye yeni eleman oluşturup eklemek için kullanılır. 
C) Yeni oluşturulan eleman kütüphane içinde istenen yere yerleştirilir. 
D) Kütüphanede varolan bir elemanı tasarım alanına çağırdıktan sonra 
ayrıştırmak için kullanılır. 

 
4. Design→Exit to Parent seçenekleri ile aşağıdaki işlemlerden hangisi yapılır? 

 
A) Çalışılan tasarım alanını yok eder.  
B) Ana çalışma alanından çıkmak için kullanılır. 
C) Sub-circuit alanından ana çalışma alanına dönmek için kullanılır. 
D) Alt tasarım alanına geçmek için kullanılır. 

 
5. Tools→Bill of Materials→Defult seçenekleri ile aşağıdaki işlemlerden hangisi  

yapılır? 
 

A) Yeni model dosyası derlemek için kullanılır. 
B) Tasarım alanında bulunan devrenin netlistini çıkarır ve ARES’e geçiş yapar. 
C) Kütüphaneye eklemek için tasarım alanında oluşturulan elemana özellik 
tanımlamak için kullanılır. 
D) Tasarım alanında bulunan çalışmanın parça listesini çıkarır. 

ÖLÇME VE DEĞERLENDİRME 
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6. Tasarım alanındaki devrede elektriksel hata olup olmadığını test etmek için aşağıdaki 
işlemlerden hangisi yapılır? 

 
A) Tools → Wire Auto Router 
B) Tools → Electrical Rule Check 
C) Tools→ Netlist Compiler 
D) Tools → Model Compiler 

7. Aşağıdaki butonlardan hangisi yeni bir eleman oluşturmak için kullanılır? 

A)        B)                         C)     D)  
 
8. Yeni oluşturulan elemanı kütüphanede istediğiniz yere eklemek için aşağıdaki işlemlerden 
hangisi yapılır? 

 
A) Library→ Store Local Object 
B) Library → Packagign Tool 
C) Library → Compile to Libraray 
D) Library → Autoplace Libraray 

 
 
 
 
 
DEĞERLENDİRME 

 
Cevaplarınızı cevap anahtarı ile karşılaştırınız. Doğru cevap sayınızı belirleyerek 

kendinizi değerlendiriniz. Yanlış cevap verdiğiniz ya da cevap verirken tereddüt ettiğiniz 
sorularla ilgili konuları faaliyete dönerek tekrar inceleyiniz. 

 
Tüm sorulara doğru cevap verdiyseniz diğer faaliyete geçiniz. 
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MODÜL DEĞERLENDİRME 
 
PERFORMANS TESTİ (YETERLİK ÖLÇME) 

 
Modül ile kazandığınız yeterliği aşağıdaki ölçütlere göre değerlendiriniz. 

 

PUAN 

Çok 
İyi İyi Orta Zayıf Sıra DEĞERLENDİRME ÖLÇÜTLERİ 

3 2 1 0 

1 Proteus programını bilgisayara kurmak     

2 ISIS programını çalıştırmak     

3 Yeni bir tasarım alanı açmak     

4 Tasarım alanının boyutlarını ve zemin rengini 
değiştirmek     

5 Tasarım alanında yeni bir orijin noktası belirlemek     

6 ISIS programı kütüphanesini kullanarak malzeme 
kutusuna istenen elemanı çağırmak     

7 Tasarım alanında devre oluşturmak     

8 Tasarım alanındaki bir elemanın değerini ve 
sembol ismini değiştirmek     

9 Devreyi doğru bir şekilde çalıştırmak     

10 Devre bağlantılarını yaparken Bus ( çoklu yol ) 
kullanmak     

11 Devre bağlantılarını yaparken terminal kullanmak     

12 Tasarım alanında istenen bölgede blok oluşturmak     

13 Devrenin malzeme listesini çıkarmak     

14 Devrenin elektriksel hata kontrolünü yapmak     

15 Test cihazlarını ve ölçü aletlerini devreye doğru 
bağlamak     

16 Test cihazlarını kullanarak devrenin giriş-çıkış 
sinyallerini gözlemlemek     

MODÜL DEĞERLENDİRME  
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17 ISIS programının araç çubuklarını doğru 
kullanmak     

18 Tasarım alanında grafik oluşturmak     

19 Oluşturulan grafiğin renk ayarlarını yapmak     

20 Tasarım alanında Sub-circuit (entegre devre) 
oluşturmak     

21 Tasarım alanında yeni bir devre oluşturup 
kütüphaneye eklemek     

22 Dosya kaydedip kayıtlı dosyayı açmak     

TOPLAM  

 
 
 
 
 

DEĞERLENDİRME 
 

Performans testinden 52 puan almışsanız modülü başarıyla tamamlamışsınızdır. 
İstenen sonucu alamamışsanız eksik olduğunuz noktaları tekrarlayınız. 
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CEVAP ANAHTARLARI 
 
 

ÖĞRENME FAALİYETİ-1 CEVAP ANAHTARI 
1 A 
2 D 
3 B 
4 C 
5 B 
6 A 
7 A 
8 C 
9 B 
10 D 

 
 

ÖĞRENME FAALİYETİ-2 CEVAP ANAHTARI 
1 D 
2 B 
3 A 
4 D 
5 A 
6 C 
7 A 
8 C 
9 A 
10 B 

 
 

ÖĞRENME FAALİYETİ-3 CEVAP ANAHTARI 
1 A 
2 A 
3 B 
4 D 
5 C 
6 D 
7 B 
8 B 

 
 
 
 
 

CEVAP ANAHTARLARI 
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ÖĞRENME FAALİYETİ-4 CEVAP ANAHTARI 

1 B 
2 C 
3 D 
4 A 
5 D 
6 A 
7 D 
8 B 

 
 

ÖĞRENME FAALİYETİ-5 CEVAP ANAHTARI 
1 C 
2 A 
3 B 
4 C 
5 D 
6 B 
7 D 
8 A 
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